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Chapter 1.  Tamaulipas Background and Significance 

 

1.1 Background 
The state of Tamaulipas is the top oil producing state in Mexico and officials are anticipating a 
surge in fracking activity in the future. Still in the early stages of unconventional or shale oil and 
gas production, opportunities can be found in developing the area. It is likely that Mexico will 
seek partnerships with independent oil companies for expanded fracking activity. To this end, the 
approval and management processes are being streamlined, while efforts are being made to 
increase government transparency. The Federal Government is working to decentralize some 
functions, improve infrastructure, and is taking steps to increase safety for those working in the 
Mexican interior. With no other country besides the United States having seen such a significant 
increase in shale gas production over the last decade, Mexico has a chance to open up their 
horizons and access major shale formations in their country.  

Fracking in Tamaulipas is likely to be focused in Burgos Basin, which is Mexico’s most 
promising shale gas resource (EIA, 2015a; EIA, 2015b). Developing fracking in this area will 
require operators to solve logistical challenges. Tampico-Misantla Basin, located in the southern 
part of Tamaulipas, also has reserves set aside for drilling. These two formations will require 
much infrastructure development. For example, the transportation infrastructure contains a 
network of paved roads but there are many unpaved roads that will experience substantial traffic 
and subsequent damage. Moreover, appropriate water sources needed for fracking are limited 
throughout the area of Tamaulipas. Yet, reservoirs can be found toward the north, south, and 
middle of the state to conserve water. West of the Sierra Madre Occidental, Tamaulipas 
experiences moderate amounts of rainfall yearly with milder winters. In addition, fracking water 
sources that would compete with the needs of the population and/or agriculture are not feasible 
options. As a result, locations for safe disposal of water used during fracking must be 
determined, and transporting water across roadways is another factor that will affect road usage 
during fracking activities.  

1.2 Energy Industry in Mexico 

1.2.1 Overview of Geological Provinces in Tamaulipas 
The State of Tamaulipas contains four basins within its boundaries: the Burgos Basin, the 
Sabinas Basin, the Tampico-Misantla Basin, and the Magiscatzin Basin (Figure 1.1). The 
Sabinas Basin only touches a relatively small area of Tamaulipas and does not have any oil and 
gas fields within the boundaries of the State. On the other hand, there is not very much 
information quantitatively assessing the Magiscatzin Basin’s resource potential. Thus, it has not 
been identified as a top target for oil and gas recovery. Mainly two basins, the Burgos and the 
Tampico-Misantla, are considered the top potential prospects for hydraulic fracturing (see Figure 
1.2). These basins contain various shale formations that have the potential to produce oil and gas. 
Overall, the two principal formations present within the Burgos and Tampico-Misantla basins are 
the Eagle Ford-Agua Nueva Formation and the La Casita-Pimienta Formation (Galicia-Barrios, 
2013).  
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Figure 1.1 Geological Provinces in Mexico  

 (Source: USGS, 2014) 
 
Burgos Basin 
The Burgos Basin is a resource rich area with high prospects for drilling. Under Bid Rounds 2 
through 4, CNH will put out to tender a total of 14,406 km2 of license block area in the Burgos. 
The main target formation in the north is the Eagle Ford Shale. In the south part of the basin, the 
main target formations are the Pimienta and La Casita Formations (Stephens & Moodhe, 2015; 
EIA, 2015b). Geological assessments have revealed the presence of oil reservoirs in the Eagle 
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Ford and the presence of gas reservoirs in the Eagle Ford, Pimienta, and La Casita Formations. 
This basin has the potential to recover shale gas and oil resources estimated at 343 Tcf1 and 6.3 
billion barrels. Exploratory shale wells have been drilled in the Burgos Basin to gather data about 
the accessibility of these resources.  
 
Tampico-Misantla Basin 
Also located in Tamaulipas, the Tampico-Misantla Basin begins at the southern tip of the state. 
The Tampico-Misantla Basin will be the main contender of the Round 1 bids (Oil & Gas Journal, 
2016). Moreover, CNH plans to put out to tender 17,625 km2 of license block area in this basin 
(Stephens & Moodhe, 2015). While significant unconventional drilling has not yet occurred 
(ARI, 2013), the Tampico-Misantla Basin has a series of conventional oil fields having produced 
around 23 Tcf and 5.5 billion barrels of oil from over 20,000 wells since the year 1904 (Stephens 
& Moodhe, 2015). This particular basin lies between the Sierra Madre Oriental on the east and 
the Tuxpan Platform toward the west where it is known to produce from some of the oldest 
reserves. The Pimienta Formation has been identified as the main target for hydraulic fracturing 
with both oil and gas prone widows (EIA, 2015b).  
 

                                                
 
1 Basins are measured in terms of trillions per cubic feet (Tcf). 
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Figure 1.2 Onshore Shale Gas and Shale Oil Prospects in Eastern Mexico, 2013  

(Source: ARI, 2013) 

1.2.2 Energy Industry in Mexico 
Information about Mexico’s burgeoning energy industry is available, including the locations of 
basins, main water infrastructure, and major pipelines. In the past, research faculty and graduate 
students have traveled to the interior of Mexico collecting literature about the history, geography, 
and Mexico’s transportation systems.  In the recent years, there has been a reduction in travel 
into the interior. Most research is carried out using accessible data and general information from 
reputable public sources. Available charts and graphs show how the geological structure of 
Mexico is quite complex throughout the country. Mexico has coastal shales of narrow 
composition that are less continuous or more disrupted in structure when compared to the shale 
formations in Texas and Louisiana.   

Figure 1.3 illustrates a cross-section of onshore shale targets in the Sabinas, Burro-
Picachos, Burgos, and Tampico-Misantla Basins in Eastern Mexico. The shale formations are 
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shaded in black and the stars indicate potential targets for oil and/or gas products. The United 
States Geological Survey (USGS) was able to assess the potential for unconventional resources 
of shale-gas or shale-oil reservoirs by noting the high levels of organic carbon and thermal 
maturity for oil and gas production (2014). These unconventional resources have been explored 
for drilling, and the prospective resources have been found to show a number of areas under 
consideration.  
 

 
 

Figure 1.3 Cross-Section of Shale Targets in Eastern Mexico, 2012  
(Source: Escalera Alcocer, 2012) 

 
Opportunities for extraction and exploration of unconventional resources are still in its early 

stages. Within Tamaulipas, the prospective resources to be put out to tender are focused near the 
panhandle, middle, and southern portion of the state. As conventional resource exploration 
approaches, areas for drilling are continuing to be put out to tender by SENER.  

1.2.3 Five Year Tender Plan for Exploration and Extraction of Hydrocarbons 
Developed from CNH’s proposal, Mexico’s Five Year Plan was published by SENER and 
considered policy elements necessary for tender viability.  The plan contains 96 exploration areas 
and 237 extraction areas, spanning a 235,070 km2 area. The fields up for tender are divided into 
groups that will be offered to bidders in various rounds. SENER plans to make additions or 
modifications to promote a comprehensive policy in design for the oil sector.  
 Round Zero allocated Pemex prospective resources as well as proven and probable 
hydrocarbon reserves (2P) in conventional, deepwater, and non-conventional formations. The 
resolution allowed Pemex to keep 100% of its requested 2P reserves (83% of Mexico’s 2P 
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reserves) and only 67% of its requested prospective resources (PEMEX, 2014). Most of 
PEMEX’s awarded resources lie in conventional basins.  

The Five Year plan divides the fields up for tender to private, international companies 
into four different rounds, and each round is divided into a number of phases. Round One is 
divided up into four phases tendering offshore exploration, offshore extraction, deepwater 
exploration, and onshore extraction lease blocks. Round 2 will offer the same categories of 
opportunities as Round 1 with the addition of onshore/offshore exploration lease blocks. Round 3 
and Round 4 will be the only rounds not offering heavy crude lease blocks. Unconventional 
exploration blocks will be offered each round in Tamaulipas (Figure 1.4). The orange, yellow, 
green, and blue indicate unconventional lease blocks up for tender during Round 1, 2, 3, and 4, 
respectively. With the exception of Round 3, most lease blocks offered for unconventional 
exploration are located in Tamaulipas.  

 
Figure 1.4 Areas of Unconventional Resource Exploration  

(Source: Tamaulipas 2016) 
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1.3 Obtaining Approval to Drill 

1.3.1 General Process 
Mexico’s complex approval and management process involves at least eight Federal Agencies. A 
summary of the regulatory agencies is in Section 1.4. Mexico is currently in the process of 
streamlining its processes. Figure 1.5 shows an overview of the process. Generally, the process 
begins with a visit with PEMEX to hiring approval.  Then, project is submitted to CNH, the 
Energy Regulatory Commission, for approval. Finally, SENER executes contracts and handles 
financial reporting.  
 

 
Figure 1.5 Approval Process for Fracking Activities 

3rd Transitory Law for Hydrocarbons Translated from Spanish. Original language available at 
www.ronda1.gob.mx. 

 
Currently, CNH is operating under Round 1 and the information about the bidding 

process, the timeline, and bidding documents can be found online. The website’s main page, 
http://www.ronda1.gob.mx, shows the links to that lead the user to each phase’s section. After 
clicking on a phase, the website navigates the user to the phase’s main page. The top bar has a 
menu called “Proceso de Licitacion” (in English, Tender Process), which will navigate to the 
user to an overview of the bidding process specific to the phase, the timeline specific to the 
phase, and bidding documents.  

At the end of each Round, exploration and production rights are granted to the winning 
Operator, however, it may be necessary for the Operator to seek additional permits. In the case of 
an exploration lease block award, the rights to explore do not grant the right to drill. In order to 
drill, there are other permits that an Operator will need to acquire. CNH is the agency that will 
grant drilling permits (Arangua, Valadez, & Ortiz, 1998-2016).  

Mexico is currently undergoing many changes during its Energy Reform, and as a result 
specific fracking regulations have not been released. Mexico will continue to award license 
blocks for unconventional exploration and extraction. As of May 2016, regulations, special 
licenses, and/or environmental permits specific shale gas exploitation have not been developed 
(Arangua, Valadez, & Ortiz, 1998-2016). Many laws have been updated and regulations are 
changing, so there is always a possibility that new legislation may be added in the future. 
 

 
 

PEMEX!

• Es(mate!the!
reserves!
• Hire!cer(fiers!

CNH!

• Green8light!for!
3rd!party!
cer(fica(on!
reports!
• Approval!and/or!
adop(on!of!
PEMEX!reports!

SENER!

• Register!the!
values!of!the!
reserves!!
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1.4 Regulatory Agencies  
The following summary information for the various regulatory agencies involved in the 
permitting process for fracking is derived from information authored by (Ruffo, Torres, Miranda, 
& Simon, 2015).  

1.4.1 SENER (Ministry of Energy)  
SENER is Mexico’s Ministry/Secretary of Energy. They delegate the following:  

• Granting exclusive exploration and production agreements for Pemex. 
• Selection of the blocks for public bidding. 
• Technical design of contracts through which Mexico grants new exploration and 

production contracts. They design contracts for both Pemex and private parties. 
• Technical requirements to be followed in the public bid for exploration and production 

contracts. CNH is responsible for the bidding process. 
• SENER has official standards for dealing with environmental health and safety in 

transportation and distribution pipelines projects. The Employment Ministry and CNH 
also have health and safety standards. 

1.4.2 CNH (National Hydrocarbon Commission)  
The Comisión Nacional de Hidrocarburos (CNH) is Mexico’s energy regulatory agency. They 
regulate and supervise the exploration and extraction of hydrocarbons, as well as processing, 
transporting, and storing Pemex’s hydrocarbons.  Right now, most of CNH’s work is for Pemex, 
but it is possible that the developing new energy reforms will broaden their scope to include 
environmental protection, safety, and reserve maintenance. They are responsible for:  

• Providing technical advice to SENER.  
• Collecting geological and operational information associated with exploration and 

production activities. 
• Authorizing recognition and superficial exploration services. 
• Carrying out public bids for the award of exploration and production contracts. 
• Defining the winners of bids and executing agreements with the bidder.  
• Managing exploration and production contracts. 
• Supervising the extraction programs. 
• Issuing regulation associated with the exploration and production of hydrocarbons. 
• Grants, subject to the fulfillment of the required procedures, licenses, exploration and 

production contracts and geophysical and geological exploration permits, as well as 
drilling permits (Arangua, Valadez, & Ortiz, 1998-2016) 

• Ensuring health and safety in oil and gas exploration. The Employment Ministry is also 
involved with health and safety regulation. 

1.4.3 CONAGUA (National Water Commission) 
CONAGUA is the National Water Commission in Mexico which respectively preserves the 
national water to sustain use. They are in charge of the following: 

• Regulating the use, extraction, and dumping of water 
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• Publishing yearly volume available for extraction from each watershed 
• Granting yearly volume concession from CONAGUA required in order to extract water 
• Issuing the required federal permit for the use, extraction, and dumping of water 

o Depending on the amount of water, may also need an additional environmental 
permit from SEMARNAT (Section 1.4.7) 

1.4.4 CRE (Energy Regulatory Commission)  
The CRE regulates natural gas and electricity downstream activities. It also grants permits for the 
storage, transport, and distribution of crude oil, oil derivatives, and petrochemicals through 
pipelines.  

As of 2014, there is no access for third parties to upstream and midstream oil and gas 
pipelines and downstream pipelines because Pemex is the only producer and thus the only one 
who uses the pipelines.  

Pemex has included obligations for third-party contractors in their production services 
contracts. New contractors are required to share infrastructure and pipelines with Pemex and 
other contractors.  The contractor must allow access to pipelines and other associated 
infrastructure in their contractual area if Pemex or another third party requires access to the 
infrastructure. In general, distribution and transportation permit holders must provide open 
access to their pipelines and networks. Open access may be executed through a service 
agreement.  
 
Pemex 
Pemex participated in the 2015 Ronda 1 / Round 1 bidding process independently and in 
association with other companies. Throughout 2015, Pemex planned to establish 10 partnerships 
to develop 14 fields under a joint venture scheme (SENER, 2014). Pemex has its own internal 
policies and procedures for self-regulation, in addition to CNH’s guidelines and policies.  

1.4.5 CNIE (Foreign Investments National Commission)  
The Comisión Nacional de Inversiones Extranjeras (CNIE) is the Foreign Investments National 
Commission. Responsibilities include:  

• Dictate policy guidelines on foreign investment and design mechanisms to promote 
investment in Mexico 

• Resolve, through the Ministry of Economy, on the source and where appropriate, on 
terms and conditions for the participation of foreign investment 

• Being an organ of obligatory consultation on foreign investment 
• Set criteria for the application of legal provisions for agencies of the Federal Public 

Administration 

1.4.6 Secretaría del Trabajo y Previsión Social (Employment Ministry) 
The Employment Ministry has in place several environmental and safety guidelines and official 
standards that all Mexican companies must comply with.  

• Ensuring health and safety in oil and gas practices 
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1.4.7 SEMARNAT (Ministry of Environment and Natural Resources)  
SEMARNAT is Mexico’s Ministry of Environment and Natural Resources. They evaluate the 
environmental impact of fracking activities and issue additional environmental permits as 
needed. They also oversee the handling of hazardous waste.  Once a project is submitted to 
SEMARNAT for evaluation and approval, a summary of the project is published in the Federal 
Ecological Gazette and in a widely distributed newspaper. SEMARNAT has two pieces of 
legislation: LGEEPA and LGPIGIR, which are described below.  
 
LGEEPA (General Law of Ecological Balance and Environmental Protection) 

• Provisions for Single Environmental License for air emissions generated from fixed 
sources 

LGPGIR (General Law for the Prevention and Integral Managing of Waste) 
• Describes procedures for environmental remediation at sites damaged or contaminated 

with hazardous waste or substances.  
• Guidelines for identifying hazardous waste. 

1.4.8 Local Government: Municipalities 
A municipality (municipio) is a basic unit of government within Mexico. Municipal governments 
headed by a municipal president (regente) hold responsibilities similar to counties in the U.S. 
These governments are responsible for a variety of services to include:  

• Managing public safety on local streets and roads 
• Maintaining public services such as water and sewage, etc. 
• Assist in caring for parks, gardens, and cemeteries 
• Emitting construction permits within their territorial limits 
• Allowing or forbidding fracking within their territorial limits 

1.5 Existing Permits and Wells 
Contractors of Pemex and investors have been exploring, extracting, and participating in farm-
outs within Mexico. At this time, contracts are being permitted out to those seeking interest in 
drilling south in Tamaulipas. The major unconventional petroleum systems within Tamaulipas 
are located in the Tampico-Misantla and Burgos Basins. Up until recently, fracking in 
Tamaulipas had only occurred in a select few exploratory wells. In February 2016, CNH granted 
Pemex the first permits allowing the petroleum company to frack in Tamaulipas as well as in 
Veracruz (Regeneración, 2016). Figure 1.6 shows the previously existing conventional wells 
owned by Pemex and investors as well as the existing pipelines. 
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Figure 1.6 Drilled Wells South of Tamaulipas, 2014  

(Source: SENER, 2014) 
 
The light blue shows the exploration blocks up for tender in Round 1, and as such the potential 
area where new wells will be located. Moreover, the dark blue shows the extraction blocks 
offered in Round 1. There are some current Pemex contracts in the very southern portion of 
Tamaulipas, but these already existing wells are not connected to any pipelines within the state.  
 Near the Mexican-American border, there is a considerable amount of conventional wells 
already drilled, a few areas with current Pemex contracts, and a very small block up for tender 
(Figure 1.7).  
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Figure 1.7 Drilled Wells in near Mexican-American border, 2014  

(Source: SENER 2014) 
 
Where the existing wells are heavily concentrated, pipelines already exist. The existing drilled 
wells in Coahuila are very spaced out, but not few in number. The light blue area has been 
classified as an exploration area for Round 1 with the potential for reserves, indicating that the 
probability that new wells may be drilled in that location in the future. 
 

1.6 Infrastructure Support 

1.6.1 Pipelines 
The construction of pipelines allows for natural gas to be supplied in the center and toward the 
west within the country. The demand for electricity and natural gas production is supported, and 
as well as natural gas exports across the world. Figure 1.8 shows the path of three major 
pipelines in Tamaulipas. The pipelines connect and distribute as follows:  

• Intra-country oil pipeline from Tampico at the very southern tip of Tamaulipas to 
Monterrey, just west of Tamaulipas in the mountains of Nuevo Leon. 

• Intra-country natural gas pipeline from Reynosa in Northern Tamaulipas, just south of 
McAllen, Texas, to Merida on the Yucatan peninsula. 

• Intra-country natural gas pipeline from Reynosa to Monterrey  
• Intra- country natural gas pipeline from Reynosa to Nueva Rosita in Coahuila (pipeline 

runs parallel to the border with Texas and passes through the states of Tamaulipas, Nuevo 
Leon, and Coahuila. Nueva Rosita is about 150 miles as-the-crow-flies from Big Bend). 

• Intra-country products pipeline from Monterrey to Ciudad Madero, just north of 
Tampico. 
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• Cross-border natural gas pipeline (the only cross-border pipeline in Mexico, according to 
the map) runs from Reynosa, Tamaulipas to El Paso, Texas.  
 

 
Figure 1.8 Pipelines in Mexico: Crude Oil, Natural Gas, and Products Pipelines 

(Source: Teadora, 2008) 
 

The end of Pemex’s monopoly on drilling activities creates a critical opportunity to 
modernize Mexico’s oil and gas industry. Particularly, pipelines drawn throughout the country 
could help unify the oil and gas industry between Mexico and the United States. Energy needs 
could be consolidated in the future. One result of new infrastructure development could be that 
Tamaulipas would be able to export resources.  

1.6.2 Water Transport Infrastructure 
This section briefly summarizes water transport infrastructure. Mexico has several water 
infrastructure projects underway to build dams, aqueducts, sanitation systems, and desalinization 
plants.  There are two desalinization plants on the west coast in La Paz, in the Baja California 
Sur. Construction is in the planning stages for three more plants in the region (CONAGUA, 
2016; Arcos & Manuel, 2015).  

Two aqueducts are being built in Tamaulipas. The proposed Monterrey VI aqueduct is 
shown below in Figure 1.9. The aqueduct passes through Tamaulipas to deliver water to 
Monterrey in the state of Nuevo Leon. It is uncertain whether cities in Tamaulipas will be able to 
access the water.  
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Figure 1.9 The proposed Monterrey VI Aqueduct  

(Source: CONAGUA) 
 

Construction on the Guadalupe Victoria Aqueduct began October 2014 (See Figure 1.10). 
When complete, it will transport water from the Vicente Guerrero Dam to Ciudad Victoria, the 
capital of Tamaulipas.  

 
Figure 1.10 Completed Guadalupe Victoria Aqueduct, Tamaulipas  

(Source: CONAGUA) 
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1.7 Fresh Water Sources 

1.7.1 Climate 
Tamaulipas has limited freshwater sources. In most of the state, surface water is limited, 
groundwater is over-utilized, and water sources are slow to renew due to high temperatures and 
low rainfall compared to the amount of water lost to evaporation.   

The state experiences a varied climate. As shown by Figure 1.11, four climate types 
coexist in the state of Tamaulipas. Generally, rainfall increases and temperatures decrease in the 
southern areas of the state. The northwestern part of the state experiences steppe climate with an 
average annual temperature above 64.4°F, with dry winters. Most of the state experiences a 
semiarid climate with small to moderate rainfall in all months, dry winters, and increased rainfall 
in autumn.  The southern portion of the state experiences a dry, subhumid climate. The semi-
tropical area in the Sierra Madre Occidental, to the southwest, has cooler temperatures and 
higher rainfall than the rest of the state. Figure 1.12 illustrates the average rainfall for Matamoros 
in the northeast of the state, and Tampico, in the southeast of the state. In Matamoros, 
approximately two months of the year receive more rainfall than is evaporated. Tampico, by 
contrast, experiences cooler temperatures and more rain, so the soil is able to recharge during 
four months of the year.  

 

 
 

Figure 1.11 Climate of Mexico  
(Source: Arbingast et al., 1975) 
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1.7.2 Water Availability 
Mexico does not have deep, extensive lakes; the volume of water stored in lakes and lagoons is 
small—just over 6.3 km3.  Of the water stored in dams and reservoirs, about 80% is discharged 
into the sea without being consumed and a large amount evaporates into the atmosphere. Of the 
remaining water available for consumption, agriculture uses 77%, the public uses 14%, and 9% 
is used for industrial purposes (SEMARNAT 2015; CONAGUA, 2008).  

Water availability per capita has decreased over time in Mexico. In 1950, the average 
availability was 17,742 m3 per capita, which was reduced in 1960 to just less than 11,000 m3.  In 
1970, it fell below 8,000 m3. In 2007, water availability per inhabitant was 4,312 cubic meters 
per inhabitant per year. This is below the lower limit of the World Resources Institute’s “low 
availability” classification. This is less than half the per capita availability of the US (10,270 m3).  
That year, the National Population Board (CONAPO) estimated that by the year 2010 water 
availability per capita would fall to 4,210 m3 per capita and in 2030 there will be 3,783 m3 per 
inhabitant per year (SEMARNAT, 2015).  

The availability of water by administrative water region is shown in Figure 1.12. The 
administrative water regions are roughly delineated along climactic and geographic lines. 
Tamaulipas is divided into Region VI and Region IX. Region VI has an average 1,124 m3 per 
inhabitant, which is only 124 m3 above the World Resource’s Institute’s “extremely low 
availability” classification. When water availability falls below 1,000 m3 per inhabitant per year, 
food security and economic development are severely compromised.  Mean total natural surface 
runoff for Region VI is 6,857 hm3 and their average aquifer recharge is 5,157 hm3. It is important 
to note that most of the Burgos Basin lies in the in VI (SEMARNAT, 2015). Region IX has 
better water security, with an average 5,162 m3 per inhabitant per year. But if Mexico includes 
surface runoff in the calculations, inhabitants are able to access the stated 5,162 m3 per year. 
Mean total natural surface runoff is 24,227 hm3 and the aquifer recharge is only 1,274 hm3 
(SEMARNAT, 2015).  

 

 
Figure 1.12 Pressure on Water Resources Per Hydrologic-administrative Region, 2007  

(Source: CONAGUA via SEMARNAT) 
 



 17 

It is clear that water is in short supply in Tamaulipas. Figure 1.13 shows the demand that 
water resources experience naturally. There is anywhere from 1,000 to 10,000 m3 of available 
water. In Region Vi, 76% of available water sources experience demand.  

 

 
Figure 1.13 Demand on Water Resources per Hydrologic-administrative Region, 2007  

(Source: CONAGUA via SEMARNAT) 
 

Most of the water in the portion of Tamaulipas lying in Region IX comes from the aquifers and 
surface reservoirs in the southwest part of the state where there is no oil.  While it would possible 
to transport this water to potential fracking sites, this could have negative effects on the low 
volume roads of the state since water is a heavy commodity. Southwest and South Tamaulipas is 
at the foothills of the Sierra Madres, with a beautiful mountain backdrop, a lake surrounded by 
tropical forest, and sunken lagoons embedded in the underlying karst formations otherwise 
recognized as cenotes (See Figure 1.14). This ecologically rich area with natural pits or sinkholes 
has attracted tourists for years, benefitting the local economy.  
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Figure 1.14 Water Features and Tourist Destinations in South Tamaulipas 
Sources: http://www.surdetamaulipas.com.mx/aldama_mapa.htm,  

NASA satellite via Cusco Web: http://www.cuscoweb.com/noticias/detalles.php?d=6939, and 
http://turismo.mexplora.com/los-cenotes-de-mexico/#prettyPhoto 

 
A map of irrigated areas, reservoirs, and subterranean water is shown below in Figure 

1.15 and Figure 1.16. A string of reservoirs in the northwest has a capacity of more than one 
billion cubic meters. Further south is a reservoir of between 10 million and 100 million cubic 
meters and several rivers. In 1970 there was a large reservoir under construction near Ciudad 
Victoria, the state capitol.  This reservoir is visible on the map. Since 1970, Mexico has added 
more dams (see Figure 1.16). 

 

Cenote!Aldama!

Cenote!Zacaton!

Cenote!Zacaton!
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Figure 1.15 Irrigated Areas, 1970  
(Source: Arbingast et al., 1975) 

 

 
Figure 1.16 Distribution of Major Dams in Mexico, 2007  

(Source: CONAGUA, 2007 via SEMARNAT) 
 
There are several reservoirs varying in size along the U.S. border (See Figure 1.17).  

Falcon International Reservoir is a reservoir on the Rio Grande near Laredo, Texas / Nuevo 
Laredo, Tamaulipas. It provides water conservation, irrigation, flood control, and 
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hydroelectricity to both Tamaulipas and Texas. Tamaulipas has rights to 41.4% of the total 
conservation capacity. As of May 18, 2015, the total conservation storage of the reservoir is 
651,799 acre-feet (Water Data for Texas, 2015).  

 

 
 

Figure 1.17 Water Reservoirs in North Tamaulipas  
(Source: Google Maps) 

 
Another likely, formerly considered source for obtaining usable water is the Rio Bravo. 

However, through recent research of the area, the Rio Bravo (otherwise called the Rio Grande) 
will not have the means to support the amount of water needed for fracking. The Rio Grande is 
one of the longest rivers in America providing a boundary between the United States and 
Mexico. With the climate and allocation of resources, the area of discharge shrinks heading 
downstream. Around 2002, the reduction of flow from the river had led to blockage of sand to 
the mouth of the river near the Gulf of Mexico. This challenge resulted in compliance issues 
among international treaties.  
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Certainly, the government has addressed improvements for the distribution of water to 
decide on how to better use the international border. Wastewater treatment plants are to be 
constructed with the oxidation of lagoons in mind. The Border Environment Cooperation 
Commission analyzed the design procedures of Wastewater Infrastructure where they justified 
using reliable and efficient collection systems based on deliverability.   

1.8 Transportation and Infrastructure 
The conditions of roads in Mexico vary widely depending on the city. Road markings, signage, 
and overall street appearance differ in quality. Often times, accidents involving heavy trucks 
occur on roadways where high volumes of traffic exist. Usually isolated roads are to be avoided 
during late afternoon and early evening hours. Mexico’s federal agency, the Secretaría de 
Comunicaciones y Transportes (SCT), allocates funds for Mexico’s building of modernized 
roads. Of those funds, investments are authorized for the development of communities. 
Specifically for Tamaulipas, rural development projects have become a sought after solution to 
problems or obstacles. Areas of potential growth were identified and given supportive funds to 
be used for equipment and infrastructure. This resource provides potential for resolving issues 
involving roads and safety. The SCT seeks to develop a sustainable economy by using their 
resources to fund different needs within the country. Administrative bodies are set-up to regulate 
the funding spent on modes of transportation.  

The road network of Tamaulipas is made up of four distinctive parts: federal, state, rural, 
and improved roads. Generally the federal roads have the strongest pavement sections so they are 
best equipped for use by heavy truck loadings, however, the improved roads generally have 
much weaker pavement structures so they are susceptible to develop pavement damage with 
large, heavy truck loadings.  

Tamaulipas is divided into municipalities, in which each municipality is in charge of its 
local streets. However, while they are in change of major road construction on their local streets, 
the budget of each municipality tend to be small.   

1.8.1 Roadway Conditions 
The area of Reynosa, Tamaulipas established goals relating to the strengthening of 

pavement and urban infrastructure improvements. Roadways were paved with several points in 
mind: nearness to city, ongoing traffic, and influence of transportation patterns. The purpose of 
choosing these particular roadways was to promote development in the community while 
improving the quality of life. The Border Environment Cooperation Commission showed how 
changes could be made to the urban road system to reduce travel times.  

Unpaved roadways, no matter urban or rural, tend to be significantly impacted by heavy 
truck traffic. To examine further, about 40% of the streets in Reynosa are paved, 200 million m2. 
However, 60% of the city roads lack pavement and these produce excess vehicular emissions and 
dust. In essence, street paving will lessen the exposure of inhabitants to particulate matter caused 
by traffic on the roadways. Unpaved roads experience significant impacts due to truck traffic and 
the impact increases with the number of truck trips.  
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Table 1.1: Table Dictionary of Terms and Definitions 
 

Dictionary*of*Terms*and*Definitions!

Approval*(of*contracts,*applications,*legal*documents,*etc.)!–!aprobación!or!visto!bueno!

Embalse*Internacional*Facón!–!Falcon!International!Reservoir,!a.k.a.!Falcon!Lake.!It!is!a!reservoir!on!the!
Rio!Grande!near!Laredo,!Texas!/!Nuevo!Laredo,!Tamaulipas.!It!provides!water!conservation,!irrigation,!
flood!control,!and!hydroelectricity!to!the!area.!Tamaulipas!has!rights!to!41.4%!of!the!total!conservation!
capacity!(Water!Data!for!Texas,!2015).!*

Energy*Regulatory*Commission!(ERC)!is!called!!(CNH)!in!Mexico!

Environmental*Impact*Assessment*(EIA)*is!required!for!fracking!activities.!The!assessment!is!submitted!to!
SEMARNAT.!It!is!unclear!whether!SEMARNAT!actually!assesses!the!activities!independently!of!the!oil!
company’s!assessment,!but!they!do!seem!to!process!the!paperwork!and!grant!authorization.!SEMARNAT!
grants!authorization!within!60!days.!It!can!be!extended!another!60!days!according!to!the!complexity!of!the!
project!(Landa!Ruffo,!2014).!!

Extracción*de*gas*non*convenciónal*–!unconventional!extraction!of!gas.!Some!Spanish8language!sites!refer!
to!fracking!this!way.!!

Falcon*International*Reservoir*–*Embalse!Internacional!Facón.!See!entry!above!for!more!information.!

Federal*Ecological*Gazette*publishes!a!list!of!potential!fracking!endeavors!that!have!been!submitted!to!
SEMARNAT!for!evaluation!and!approval.!

Fractura*hidráulica*/*fracturación!hidráulica!*–!hydraulic!fracturing,!i.e.,!“fracking.”!Fractura!hidráulica!es!
methodologiás!para!la!evaluación!de!reservas!de!hidrocarburos!técnica!de!fracturación!hidráulica!para!la!
extracción!de!gas!non!convenciónal.!

Hidrocarburos*–!hydrocarbons,!e.g.,!crude!oil,!methane,!petroleum,!butane!

CRE*–!Energy!Regulation!Commission!!

Comisión*Nacional*de*Hidrocarburos*(CNH)*is!Mexico’s!Energy!Regulatory!Commission!

Gas*non*convenciónal*–!“unconventional!gas.”!some!Spanish8language!sites!refer!to!the!products!
obtained!by!fracking!as!“unconventional!gas.”!

LGEEPA*is!Mexico’s!General!Law!of!Ecological!Balance!and!Environmental!Protection.!It,!along!with!its!
Regulations!on!Environmental!Impact!Matters,!provides!a!list!of!works!and!activities!related!to!oil!and!gas!
that!must!be!reported!to!SEMARNAT!for!assessment!(Landa!Ruffo,!2014).!

LGPGIR*is!Mexico’s!General!Law!for!the!Prevention!and!Integral!Managing!of!Waste.!It!is!part!of!
SEMARNAT’s!regulatory!laws.!!

PEMEX*–*Short!for!Petroleos!Mexicanos,!it!is!a!Mexican!state8owned!petroleum!company.!Emilio!Lozoya!
Austin!is!the!current!CEO!of!Pemex.!!

SEMARNAT*is!Mexico’s!Ministry!of!Environment!and!Natural!Resources.!They!evaluate!the!environmental!
impact!of!fracking!activities.!They!also!oversee!the!handling!of!hazardous!waste.!!

SENER*–*Secretaria!de!Energia.!Mexico’s!Secretary!of!Energy.*

SHCP*–!Secretaria!de!Hacienda!y!Credito!Publico.!Mexico’s!Secretary!of!Ranches!and!Public!Credit.!!

Visto*Bueno*–!“green!light”!to!proceed!and/or!approval!(of!contracts,!applications,!legal!documents,!etc.)!
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Chapter 2.  Forecasting Locations and Pavement Loading  
Due to Development Activities 

Pavement maintenance is for most departments of transportation (DOT’s) one of the 
largest single cost items.  Historically over half of most DOT budgets have been spent on 
Operations and Maintenance. Unusually heavy traffic loading caused by land development, re-
development, or mining can distort expected pavement deterioration patterns, which sometimes 
cause unexpected pavement destruction.  Costs to reconstruct a destroyed pavement can be ten 
times greater than the cost of strengthening the pavement adequately to handle the heavy 
loading.  Forecasting future at-risk pavement locations can help to prevent costs associated with 
completely rebuilding destroyed pavement. In order to save money and cut down on maintenance 
costs, pavements that are likely to experience unusually severe traffic loading should be 
identified. Anticipating activities that cause increased truck loading can help prescribe 
preventative measures to reinforce pavement structures before they fail.  

The rate of pavement deterioration is dependent upon weather conditions, type of 
pavement and traffic loading. Land development activities, sometimes called land use change 
activities including mining (petroleum resource recovery), frequently cause large concentrations 
of truck traffic loading on minor roads that have weak pavement structures.  The result is 
accelerated pavement deterioration resulting in pavement destruction before maintenance 
authorities realize what is happening.  Savings of up to 90% of the cost of total pavement 
reconstruction can be achieved if sufficient strengthening to the existing pavement is made 
before it is destroyed.  

High truck flow rates typically generate heavy pavement loadings. Heavy loadings are 
generally less damaging to major highways (i.e., in Texas - Interstate, US, or State numbered 
routes) because such highways are designed to carry high volumes of heavily loaded trucks. 
However, if unanticipated heavy loadings occur on rural/local streets or low volume highways 
(i.e., in Texas - Farm to Market or Ranch to Market highways) very accelerated pavement 
deterioration occurs. Local streets are usually designed mainly to carry passenger cars and 
occasional truck traffic. County highways were designed originally for farmers to transport 
agricultural products to markets in towns and cities. Unexpected large volumes of heavy truck 
traffic with heavy loadings can pose severe effects to the pavement or even cause destruction to 
the surface of a low volume road.  

Current state of practice for maintenance differs from one state to another. Texas 
Department of Transportation (TxDOT) divides the present state of practice for maintenance into 
three categories: preventative maintenance, routine maintenance, and major maintenance. 
TxDOT defines preventative maintenance as any maintenance performed to “prevent major 
deterioration of the pavement.” Examples of such maintenance include overlays or seal coats. 
Also, major maintenance can be done to restore destroyed pavement, including replacing the 
base as well as the wearing surface. Preventative maintenance delays the need for major 
maintenance. The current planning process in each TxDOT district consists of each individual 
district developing an annual plan for maintenance projects by “analyzing historical quantities of 
work performed and the resulting level of service” (Holland, 2014). An Early Warning System 
can help capture those changes in land use and forecast their effects on pavement. This tool can 
be used to help prioritize pavement maintenance for more effective use of tax dollars.   
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2.1 Current Practice 
The current practice of maintaining pavement depends on annual reports of pavement condition 
and historical data that does not take into account unexpected traffic changes. Unexpected high 
truck traffic flow will not only damage pavements, but will produce significant economic 
impacts. Predicting truck travel patterns can serve as a potential solution to saving money on 
maintenance costs. 

Preventive maintenance is usually a cost-effective procedure that is done to extend the 
pavement’s life. According to Galehouse (2003), “preventive maintenance can extend pavement 
life an average of 5 to 10 years.” However, preventive maintenance should be applied on the 
pavement at a specific time frame before failure in order to maximize effectiveness. The current 
state of practice for maintenance planning does not include provision for sudden, unexpected 
changes in typical traffic patterns. This is due to the deficiency of truck data, which plays a 
major role in damaging pavements. Truck trip characteristics are usually related to the associated 
industry. Studying industries related to the growth of truck traffic in an area can help provide 
truck movement data. 

2.2 Early Studies: Characterizing Pavement Failure 
The American Association of State Highway Officials (AASHO) conducted the early studies 
quantifying the effect of traffic on pavement. AASHO saw the need to develop standards to help 
build better roads. The lack of data for pavement design and the need to save money by 
optimizing design methods was the motivation behind this study. The AASHO pavement design 
method quantified pavement failure for the first time and introduced the equivalent axle concept. 
The equivalent axle concept provides an expression of the pavement damage caused by one pass 
of any axle weight compared to the damage caused by one pass of a chosen standard weight axle.  
An 18,000 pound (~8.16 metric tons) single axle is often chosen as the standard (Kawa, 
Zhanmin, & Hudson, 1998). With the tools from AASHO, we can use equivalent single axles 
(ESALs) to describe truck impacts on pavement and by that also classify road segments in terms 
of priority for future pavement maintenance projects. 

2.2.1 Previous studies: Methods for Forecasting of Pavement Failure 
Previous research has used surveys to gather data about truck movements to build statistics-
based forecasts. This pavement failure forecasting technique is effective if data is abundant and 
easy to gather but issues arise with these types of models if data is scarce. Spatially transferred 
data from similar locations can be used, but it is not sufficiently accurate for pavement failure 
forecasting. Surveys can be costly and time consuming, and updating survey data can be 
complicated.  

Truck trip modeling can help predict the trips made by trucks and pavement impact. 
Transportation Research Board Special Report 288 (TRB SR288, 2007) discussed the need for 
improving travel-forecasting models because of the lack of treatment of commercial and freight 
data. Because of the lack of truck vehicle data, researchers have designed different methods to 
predict future truck movements.  

Truck traffic production and attraction data along with a Geographic Information System 
(GIS) can be used as an alternative to develop truck flow prediction models. Tirado, et al. (2006) 
used a finite element model to calculate pavement distress and then developed a graphical output 
using Visual Basic to be used on ArcView (GIS Software) to show damages caused by super 
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heavy loads on a specific route. Tirado et al. (2006) introduced the use of GIS software to 
develop models that can help visualize locations of distress and rutting. However, ArcGIS has 
the power to be used not only as a visual tool to show outputs of other software, but also as an 
analysis tool.  Another study that used GIS based data for pavement research, Osegueda, et al. 
(1997), used overweight/oversize permit data in relationship with available GIS base maps from 
the TxDOT database to generate shortest paths between origins and destinations in Houston. The 
tool is easy to update with new data, TransCAD GIS software shows the maps, and the Dijkstra 
algorithm finds the shortest paths between origins and destinations. Osegueda, et al. (1997) 
considered the issued overweight/oversize permits and investigated conditions of bridges (using 
the BRINSAP database) along the route of the permit. However, this study only considered the 
damage on specific bridge locations and did not consider predicting where the most damage will 
occur along routes. We used truck trip generation tables, as provided by the NCHRP Synthesis of 
Highway Practice, and GIS data to characterize pavement damage in terms of ESAL loadings 
along routes. This alternative approach can save money and time in comparison to traditional 
surveying techniques. ESAL data is easily accessible and updated frequently, therefore a model 
can be built for recurrent use.  

Most planning methods for smaller urban areas and rural areas assume that trucks are 
only a small fraction of the traffic, but studies show that trucks make up a significant portion and 
should not be ignored. Cambridge Systematics (2004) used the Freight Analysis Framework data 
to analyze congestion in urban and rural areas, with and without truck data, and found that 
excluding truck data would only show congestion in urban areas and not any of the congestion 
present in rural areas. Trucks have a direct impact on congestion in rural areas.  

2.3 Previous Studies: Characterizing Oil and Gas Industry Related Truck 
Trips 
The oil and gas industry plays a vital role in the economy of Texas. The effects of truck traffic 
greatly impact the Texas road network. In 2014, there were more than 1 million active wells in 
the United States; more than ¼ of those wells are located in Texas (Kelso, 2014). The Texas 
transportation network transports oil for most of the surrounding states and its own growing 
population.  

The effect of unexpected loading has been extensively studied in the area of bridge and 
road structures, but recently this concept has received more attention for pavement management. 
The Utah Department of Transportation (UDOT) developed a pavement management manual to 
provide a cost effective solution for pavement rehabilitation design (2008). Their approach is to 
evaluate pavement prior to rehabilitation. Strategies between scheduling, organizing, and 
designing pavements were studied. A cost effective solution for each pavement condition was 
proposed. Another recent study conducted by Sianipar & Dowaki, 2014 examined the influence 
of traffic growth and overload on the road life cycle.  They found that the biggest cause of life-
performance decrease is overload, and that the effects are non-linear. The rate of damage can be 
faster than the rate of overloading.  

Several studies evaluated the expected damage and cost caused by oil and gas 
development activities. TxDOT has begun to evaluate short-term and long-term impacts of 
energy related activities on the state’s transportation infrastructure. Quiroga, Fernando, & Oh 
(2012) provided a comprehensive document on the impacts, needs, and strategies for TxDOT, 
including the effects of horizontal well activity. They estimated a typical rural road would lose 
39% of its life after one year of 100 horizontal gas wells. Considering re-fracking the wells every 
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five years, they estimated the pavement would reach the end of its life before ten years. 
Abramzon, et al. (2014) provided a similar technical report for the Pennsylvania Department of 
Transportation (PennDOT). The report revealed the per-well cost depends linearly on the number 
of truck trips and the length of the truck trip. If the average one-way trip deceases by half, the 
per-well fee could be reduced by 50%. They recommend a comprehensive design policy that 
motivates companies to minimize activities that damage the roads. Reimer and Regehr (2014) 
developed a framework for the oil and gas industry to optimize their transportation activities. 
This study develops an integrated framework for the state’s Department of Transportation to 
prioritize road segments for maintenance. However, none of these studies have recommended a 
way to determine exact location for these types of damages. 

Different studies addressed the problem of hydraulic fracturing (fracking) in relation to 
various variables. Prozzi, et al. (2011) addressed the fracking problem and its impact on 
transportation infrastructure by using GIS-based data to find the shortest route that trucks would 
take. According to Prozzi, that there is an increasing demand on the Texas infrastructure, 
especially rural roads that are used for moving equipment into sites, as 30% of the US natural gas 
and 19% of the US oil is produced in Texas. This study located active gas wells and assumed the 
closest disposal well was the one in service. The routes between the truck’s origins and 
destinations were generated through Google Maps. Vehicles Miles of Travel (VMT) was the 
variable used to emphasize the percentage of truck trips that traveled on rural roads. The research 
determined that 30% of truck trips moving water to disposal wells were using local streets.  

2.4 Methodology 
The methodology was built in three steps, beginning with generating Truck Trip Generation 
Tables based on analyzing previous studies. Gathering GIS locations of trips associated with land 
use changes that generate unexpected truck trips are added to the network. The last step links 
TTGTs to a GIS database on ArcGIS to forecast these trips shortest routes with their loadings. 
The output of the model is a map that shows locations of total loading values on each segments 
of the network.  

2.5 Urban Growth and Land Use Changes 
Urban growth usually generates rapid land use changes. These changes affect transportation 
networks as they cause more traffic to use existing infrastructure. Capturing those land use 
changes improves planning for increased pavement service life. Building a brick plant in a rural 
area generates heavy truck traffic with high loadings, causing the pavement to fail before the end 
of its expected service life. DOT districts end up paying millions of dollars to reconstruct failed 
pavements. These land use changes can be tracked and their effects on the pavement can be 
predicted. If one knows where the brick plant is going to be built, the size of the plant, the origins 
and destinations for the associated truck traffic, one could predict future damage on the routes. 
The method described uses GIS locations of future land use, type of establishments, and 
establishment area sizes.  

Based on previous studies, NCHRP 298 reported that the general practice to predict 
trucks generated by a certain land use is to use independent variables like square feet of land 
used or employment numbers to generate establishment based truck trips. Jaller, et al. (2014) 
studied 1890 models of trip rates and regression models for production and attraction and found 
41.59% of these models used area, 29.89% used employment, and 14.71% used establishment 
type. While establishment type can serve as a predictor, it could lead to errors because it over 
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generalizes the number of trips. For example, an establishment-based trip model will give the 
same number of trucks for a grocery store regardless of the size.  

Reliable truck trip forecasting uses an equation limited not only to area, employment, or 
establishment type but also includes the number of days that the establishment experiences truck 
traffic.  
!

!
Figure 2.1  ESAL Ratios During a Week  
(Source: Cambridge Systematics 2005) 

 
Figure 2.1 shows higher daily ESAL ratios from Monday to Friday, which implies that 

days of the week will generate different truck traffic rates. Tadi and Balbach (1994) built their 
truck trip rates on the fact that weekdays truck traffic rates are different than weekend rates. 
They studied truck traffic rates on a weekday and weekend basis, and included peak hour rates 
for AM and PM for weekdays.  
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!

Figure 2.2 Truck % of Traffic Over 24 Hour Period  
(Source: Cambridge Systematics 2005) 

 
Time of day plays another major role in determining traffic trips rates. Figure 2.2 shows 

the percentage of trucks over a 24 hour period. Most of the truck traffic travels during business 
hours (9:00-14:00). This may add another variable to the list of variables affecting truck trip 
generation tables.  

The last factor considered is truck type. The term truck might include any type of vehicle 
that is used to transfer products and goods. A better understanding of the degree of damage can 
be achieved by answering the question: what type of truck can be most damaging? According to 
FHWA (2000), more than 42% of the trucks in the US are 3-S2 trucks. This makes it the most 
common truck types in the United States. The 3-S2 truck configuration is shown in Figure 2.3. 
An SU2 truck is the second most common type making up more than 35% of the trucks on the 
road. An SU2 truck is a single unit with 2 axles. The rest of the configuration types are divided 
among more than nine different types and can be considered negligible due to their rare 
existence. The variables used for establishment-based Truck Trip Generation Tables are the 
following:  

• Size of Establishment (acres, square footage), 
• Employment (number of employees in each establishment), 
• Type of Establishment (rates can be generated on type of establishment only), 
• Days of activity (days that the establishment will be receiving/sending trucks), 
• Hours of activity (hours of day that that the establishment will be receiving/sending 

trucks), and 
• Truck Configuration (type of trucks).  
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!
Figure 2.3  3-S2 Truck Configuration and ESAL Loading 

 
ESALs can provide a better estimate for the damage a single pass of a truck on specific 

pavement can cause. As discussed earlier, ESALs describe the damage a specific axle load 
causes to the pavement, compared to a single axle load of 18Kip. According to FHWA standards 
for commercial vehicle weight, the maximum gross vehicle weight is 80Kips (FHWA, 2013). 
Figure 2.3 shows a likely breakdown of 80Kip and 130Kip gross weights on the axles. Assuming 
rigid pavement and structural number of two based on AASHTO design methods, Table 2.1 
shows ESAL value example calculations based on the truck weight.  

Table 2.1: ESAL Number Calculation for Different Weights 

 
 

In general, models are constructed with specific variables in mind and exclude negligible 
variables. This model was mainly focused on trucks that may cause significant pavement 
damage. In this model, these trucks travel at any time of the day, causing congestion and 
pavement related issues.  

2.6 Oil and Gas Industry Growth 
The rest of the chapter summarizes what has been learned about Oil and Gas Industry Growth in 
Texas so that the lessons learned can be applied to Tamaulipas. In Texas, oil and gas well 
locations are typically in West Texas or in the Gulf of Mexico, approximately 200 miles away 
from shore. Figure 2.4 shows the locations of active oil and gas wells. Most of them are not close 
to a major highway.  
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!
Figure 2.4 Active Oil and Gas Wells in Texas  

(Source: TCEQ 2014) 
 

Constructing and operating these wells requires transportation of equipment, water, and 
other products. The recent boom in oil and gas unconventional shale plays requires that these 
products be transported by a large number of heavy trucks, which were likely not expected 
during pavement design. Widespread use of hydraulic fracturing, or fracking, has generated more 
heavy trucks in comparison to traditional drilling activities. This is due to the high need for water 
related to each well construction and production activity. According to the US Department of 
Energy (2013), up to 95% of new wells being drilled are hydraulically fractured. These wells 
make up 43% oil and 57% natural gas production on average. The repetitive trips and loadings 
associated with servicing the wells are concentrated on low volume roads that have thin 
pavement structures. Such loadings can damage or destroy the pavement. These trips provide 
equipment, supplying water, disposing of water, and carrying aggregates and chemicals to the 
site of each oil well.  

2.7 Oil and Gas Model Truck Trip Generation Tables 
The main element transported to and from fracked wells during construction and production is 
water. The water volumes moved per well were determined from information obtained from 
fracfocus.org, a voluntary disclosure database that gives details of hydraulic fracturing in the 
United States. This site provides information about water volume, date of well drilling, and the 
percentage by weight of fracking fluids, which varies when involving water, sand, and standard 
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chemicals.  For this study, a sample of data from three counties in Texas, Caldwell, Bastrop, and 
Lee, was selected and extracted.  Locations and approval dates of oil drilling permits and active 
saltwater disposal well information was gathered from the Railroad Commission of Texas 
(RRC).  

The sample data extracted from RRC included information on 21 oil wells. The dates for 
which the permit was submitted and approved were obtained. The start date for drilling was also 
noted. The average expected time upon approval to start of drilling is around 65 days, while it 
only takes 13 days on average to construct an oil well. With respect to only horizontal fracking 
wells, the largest well may require over 9,232,230 gallons of water during its life. More water is 
required for horizontal fracking at 5,943,105 gallons per well, whereas vertical drilling requires 
about 1,389,803 gallons of water. In Texas, vertical drilling is not as common as fracking. For 
this study, the truck traffic associated with conventional vertical drilling methods is excluded.  

The quantity of sand used in fracking for each oil well must also be considered. 
According to the sample given by the RRC, only 13.18% of the total injected fluid mass is sand. 
Given the amount an average truck hauls, the amounts of water and sand supported during 
transport could be determined. Average hauling trucks can hold 20 cubic yards of sand. 
Therefore, 13.18% of 5,943,105 gallons is 3,878 cubic yards. Dividing that by 20 gives an 
estimated 194 trucks transporting sand in and out of wells. After finding the weight of the 
materials being carried, the number of trucks necessary for the process of water supply and 
disposal can be calculated. This number is estimated for the entire oil well completion. 
Quantities of water and sand are given in Table 2.2, which shows the average water volume 
utilized for horizontal drilling. Given the fact that most water hauling trucks have a 4000 gallons’ 
capacity, more than 1,486 trucks are needed to transport water for a horizontal well. 

Table 2.2: Horizontal Fracking Wells Data 

!
 

API$No. Water$Vol$(gal) Sand$% Water$% Approved Drill$Start Drill$Finish Wait Constr
28732619 7,820,526 13.58 82.58 12/4/2013 1/22/2014 1/29/2014 49 7
28732615 6,503,834 11.35 83.72 11/8/2013 2/18/2014 2/25/2014 102 7
28732621 6,020,994 12.78 83.05 12/13/2013 3/6/2014 3/13/2014 83 7
28732620 5,841,912 14.18 82.77 12/13/2013 3/6/2014 3/13/2014 83 7
28732617 7,264,716 13.27 86.71 2/26/2014 3/30/2014 4/5/2014 32 6
28732623 8,160,396 17.27 81.21 2/27/2014 4/5/2014 4/11/2014 37 6
28732628 7,243,404 13.93 76.96 3/6/2014 4/11/2014 7/16/2014 36 96
28732630 4,247,444 11.18 87.83 3/11/2014 4/16/2014 4/19/2014 36 3
28732635 5,382,036 11.22 87.69 4/9/2014 5/14/2014 5/17/2014 35 3
28732636 6,162,986 11.96 86.28 4/16/2014 5/27/2014 6/8/2014 41 12
28732626 4,544,240 11.64 86.62 2/28/2014 5/27/2014 6/8/2014 88 12
28732629 2,852,620 17.16 81.96 3/8/2014 6/10/2014 7/18/2014 94 38
28732616 4,210,796 14.41 83.51 4/4/2014 6/18/2014 6/25/2014 75 7
28732634 6,780,786 14.30 83.62 4/4/2014 6/18/2014 6/25/2014 75 7
28732641 7,037,294 12.12 84.97 5/6/2014 7/7/2014 7/14/2014 62 7
28732640 5,300,068 12.87 85.29 5/6/2014 7/7/2014 7/14/2014 62 7
28732632 9,232,230 11.65 89.44 3/15/2014 7/15/2014 7/21/2014 122 6
28732643 2,197,202 14.31 80.19 5/29/2014 7/17/2014 7/18/2014 49 1
28732646 5,286,204 13.21 83.83 6/9/2014 8/4/2014 8/8/2014 56 4
28732647 5,293,196 14.85 83.35 6/9/2014 8/15/2014 8/20/2014 67 5
28732646 7,140,462 11.29 84.94 6/9/2014 8/24/2014 9/10/2014 76 17
28732649 6,224,960 11.44 84.83 6/9/2014 8/24/2014 9/10/2014 76 17
Average= 5,943,105 13.18 84.15 65+++ 13+++++++

Horizontal+Fracking+Wells

Average$Days
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Generally, flow back of disposed water is about 20-50 percent of the total volume used in 
the fracking injection process. For the purpose of this study, a near worst case assumption of a 40 
percent flow back volume during the construction phase was used. After the initial oil well 
completion, quantities of saltwater backflows contain oil or gas being fracked. This saltwater is 
mostly disposed of after the rate of flow back decreases. At that point, the saltwater is 
transported off site by use of trucks. Figure 2.5 illustrates how the average daily truck traffic 
decreases after the initial two weeks of drilling. 

!

!
Figure 2.5 Well Production Truck Traffic  

(Source: Prozzi 2011) 
 
The highest daily truck traffic experienced after 20 days of drilling would be up to 2-3 

trips. Transporting gravel is another factor. Gravel is used to building access roads where rural 
roads are not found, such as long stretches of field. According to Kubars and Vachal (2014) 
study in North Dakota roads, approximately 80 trips are required to provide enough gravel to 
build access road. The last bit of heavy traffic generated due to the construction of new oil wells 
is traffic caused by transporting equipment. New York State Department of Environmental 
Conservation (2009) estimated the equipment truck traffic associate with the construction of a 
single gas well to be 200 truck trips. Given the low volume of equipment trips and lack of data 
on the companies providing the equipment, one could neglect this factor from the total count of 
truck traffic. 
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Table 2.3: Oil Well Construction Truck Trip Generation 
Construction Activity per Well 

Purpose Number of Trucks ESAL (Value) ESALs 
Water 1486 2.449 3639 

Water Disposal 594 2.449 1455 
Bulk Sand 200 2.449 490 

Gravel 80 2.449 196 
Equipment / Other 200 2.449 490 

Total 2560 2.449 6269 

Table 2.4: Oil Well Production Truck Trip Generation 
Production Activity (Water Disposal) 

Purpose Number of Trucks ESAL (Value) ESALs per well 
1st week 476 2.449 1166 
2nd week 196 2.449 480 

Up to 60 days 90 2.449 220 
After 60 days 30 2.449 73 
Haul Product 2 2.449 5 

Total 794 2.449 1945 
 
Table 2.3 and Table 2.4 summarize the ESAL values generated with each activity related to a 
single oil well. From this information, truck traffic diminishes during the production phase. 
During construction, which takes roughly 13 days, calculations show that 6269 ESALs (based on 
80 Kip trucks) can be expected per well. On the other hand, calculations show that a much lower 
1945 ESALs (based on 80 Kip trucks) can be expected during the production phase, which can 
last up to a year. Therefore, the construction phase occurs in a shorter period of time but is more 
damaging. For this study, truck trip generations for the construction phase with its loadings is 
used in the model and linked with routes of travel to predict pavement damages
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Chapter 3.  Texas Case Study with Stepwise Instructions 

3.1 GIS Mapping Tool 
The Network Analyst closest-facility tool identifies the shortest route between an incident and a 
serving facility. In this case, the serving facilities were locations of sand, gravel, fresh water, and 
water disposal wells. The incidents served were the wells. Linking ESAL values from the TTGTs 
with routes generated from the Network Analyst tool showed locations of heavy truck traffic 
indicating where pavement damage would likely occur. Focusing solely on construction traffic 
that occurred during a two-week period, model inputs were updated to capture changes in truck 
movement patterns. On average, it takes more than 2 months for an oil well to be built after the 
approval of the oil permit. For estimation purposes, the period of study was determined to be 3 
months. The tool was developed using truck trip generation tables linked with route assignment 
by using origin-destination in ArcGIS’s network analyst.  

The Oil and Gas Model was built for the Austin TxDOT district area for two periods of 
analysis: June-August and September-December of 2014. The model used oil well permit data to 
forecast routes between wells and origins/destinations of facilities servicing oil well construction.  

3.2 Oil and Gas Growth Model Case Study  

3.2.1 Austin District Oil and Gas Growth GIS Model Building 
The model focused on detecting changes in land-use that are specifically related to oil and gas 
Industry development in the Austin TxDOT District jurisdictional limits. Figure 3.1 shows the 
Texas counties within the Eagle Ford Shale geological area. 
 

!
Figure 3.1 Eagle Ford Shale Counties 
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 Out of those counties, Lee and Bastrop are in the Austin TxDOT District area. 

According to the US Energy Information Administration’s (EIA, 2015c) list of Top 100 US Oil 
Fields in terms of production, two fields from the Eagle Ford Shale formation are in the first and 
fifth ranking. It is also noted that the two fields’ production estimate sum is nearly half the 
production of the top 10 production estimates in total. Moreover, the Austin TxDOT District has 
11 counties, 3 out of those 11 had new oil well permits in 2014 according to Railroad 
Commission of Texas database (RRC). The Austin TxDOT district is experiencing significant 
movement of trucks serving oil wells.  

3.2.2 GIS Data Sources 
The first step in this model was to determine the data that can be gathered and implemented to 
characterize the truck travel patterns. The list of essential source locations was as follows: 

• Oil wells. RRC is responsible for regulating oil and gas permits in Texas. It is the agency 
that monitors and issues oil well permits so it is the right source of data for this model. 
The RRC online website was used to gather information regarding all the permitted oil 
wells in the Austin TxDOT district area.  

• Fresh water wells. Data describing the sources of water supply were obtained from the 
Texas Commission on Environmental Quality (TCEQ) that takes responsibility for all 
aspects of planning, permitting, and monitoring.  

• Saltwater disposal wells. Saltwater disposal well GIS locations were gathered from the 
RRC website the same way as the oil wells.  

• Quarries. Quarry locations supplying sand and gravel were provided by TxDOT Project 
Advisor Rhonda Roundy, CST.  

• Roadway network. The roadway network is one of the most important aspects to this 
project, because it geographically describes potential paths for trucks to travel.  A 
shapefile representation of the roadways was used to connect all routes and form a 
network in the ArcGIS software.  

• Texas Counties. This served as the model base map where all analysis was based. It 
showed the geographical political borders between counties. It also was used to show the 
study area.  

3.2.3 Austin District Oil and Gas ArcGIS Implementation  
ArcGIS was used to layer the retrieved information. Each location was exported as a Shapefile 
into ArcGIS providing an extensive model. The majority of the elements in the model require 
frequent updates. The RRC oil well permit data, for example, is the main layer used in mapping, 
and this data must be collected for the time period of analysis desired. 

3.2.4 Connecting GIS Data to ArcMAP 
The first step in this process is to connect the files that have all the GIS data to ArcMAP.  

On the right side of the ArcMAP main bar, click on the Window tab and select Catalog 
from the dropdown menu. Under the same Window tab, select Table of Contents to show the 
Table of Contents pane containing all the layers and loaded data. Right click on Folder 
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Connection and click on Connect to Folder, select the folder containing the GIS data, and click 
OK.  

The fracking activity in the Texas Study was analyzed by county. The steps to add in 
counties are:  

> File > Add Data > Add Data… 
Click on the file containing the county data. Keep in mind that the county data has a specific 
coordinate system that must be modified to match the GIS data coordinate system.  

3.2.5 Aligning Coordinate System 
All the files added to the model will need to be projected in order to ensure that all the data is 
aligned. ArcGIS tools are stored in the ArcToolbox window. To get to Toolboxes, click on the 
Window tab in the main bar and select Catalog from the dropdown menu. Click on the + next to 
Toolboxes, then 

> System Toolboxes > Data Management Tools > Projections and Transformations 
> Project  

A window will pop up with green dots next to the files that must be input. The following was 
used for the Texas Study, 

Input Dataset or Feature Class: Select the file user wants to align, i.e., 
StratMap_County_Poly  
Output Dataset or Feature Class: Type desired name for output data, Select where the 
data should be saved, i.e., Counties 

Output Coordinate System: Select > Projected Coordinate Systems > State Plane 
> NAD 1983 (US Feet) > NAD 1983 StatePlane Texas Central FIPS 4203 (US Feet) > 
OK > OK 

The output has the counties projected to the Central Texas projection system.  

3.2.6 Importing Excel Data to Build Shapefile 
The next step is to import the oil shapefiles. The “Make XY Event Layer” is a tool that would 
be used to create a point layer from XY data tables. The following are instructions to use the tool 
“Make XY Event Layer”: To get to Toolboxes, click on the Window tab in the main bar and 
select Catalog from the dropdown menu. Click on the + next to Toolboxes, then 

> System Toolboxes > Data Management Tools > Layers and Table View > Make 
XY Event Layer 

A window will pop up with green dots next to the files that must be input. The following was 
used for the Texas Study, 

XY Table: Select Excel file saved to 1997-2003 version, i.e., OilWells (For oil wells in 
the 1st period (June-August 2014) OilWells2 is the 2nd period) 
X Field: Select field in the input table that contains the x-coordinate, i.e. Longitude 
Y Field: Select field in the input table that contains the y-coordinate, i.e. Latitude  
Layer Name or Table View: Type in name of the output point event layer, i.e., OilWells  

Spatial Reference: Select > Projected Coordinate Systems > State Plane > NAD 
1983 (US Feet) > NAD 1983 StatePlane Texas Central FIPS 4203 (US Feet) > OK > 
OK (this is used because it contains most of counties in the study area: Bastrop and Lee. 
However, Caldwell is on South Central 4204) 



 18 

 
The output for the Texas Study is shown below. 
 

!

Figure 3.2 Quarry to Oil Wells Only (Period 1) 
The output in Figure 3.2 shows locations for oil wells converted from Excel files into 

ArcGIS shapefile and projected to the “NAD 1983 StatePlane Texas Central FIPS 4203 Feet”. 
The “Project” tool that was used to project the counties shapefile can be used for the projection 
of quarries and fresh water wells.  

3.2.7 Activate Network Analyst Extension 
After importing source information data into ArcGIS, the next step is to create a road network. 
Having a road network, one can implement network analyst’s closest facility tool to find the 
route assignment.  

 
The first step is to activate the network analyst extension:  

In main window top bar, click  
> Customize > Extensions… > Click on Network Analyst to activate it.  

Adding Network analyst toolbar as follows: 
In main window top bar, click  
> Customize > Toolbars > Click on Network Analyst to add it.  
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3.2.8 Create/build a Network Dataset 
The second step in creating the EWS model is to create/build a network dataset.  
This step is crucial to the entire system because it is the foundation of the model, and therefore 
the entire analysis. 
 
On the right side of the ArcMAP main bar, click on the Window tab and select Catalog from the 
dropdown menu. Locate the folder containing the roads that will be used in the model.  
Right click on the road file: 

> Select “New Network Dataset…” This will open a window to help build a network 
dataset.  
 Window will read: Enter a name for your network dataset. Type in the name of the file 
containing the roads, i.e. “TexasRoads” 
Window will read: Do you want to model turns in this network? Select YES. 
> Select Connectivity policy is end points 
Window will read: How would you like to model the elevation of your network features? 
> Select NONE.  
> Select proper units, i.e. “Miles”. 
> Click Next. 
Window will read: Do you want to establish driving direction settings for this network 
dataset? This depends on the user output needs, however, for this model we chose YES.  
> Select Finish. 

The output has two parts: the edges, which are the street lines and the junctions, which represent 
all the junctions in the network. In this model, only the street lines are needed. Figure 3.3 shows 
the data inputs in this model.  

!



 20 

!

Figure 3.3 All Model Inputs 

3.2.9 Adding Sources and Clipping Features of Interest 
In this third step, the user will be able to introduce all the destinations that trucks will be 
traveling to and from to service the needs of the wells in question. The last part of this section 
will show the user how to clip specific sections of interest on a giving roadway. Oil wells, 
disposal wells, and quarries are locations in the study area parameters. A guided illustration and 
breakdown of the steps needed to set up the model is as follows:  
 To get to Toolboxes, click on the Window tab in the main bar and select Catalog from 
the dropdown menu. Click on the + next to Toolboxes, then 

> System Toolboxes > Analysis Tools > Extract > Clip  
A window will pop up with green dots next to the files that must be input. The following was 
used for the Texas Study, 

Input Features: Select features to be clipped, i.e., FreshWater  
Clip Features: Select featured use to clip the input features, i.e., SurroundingCounties 
Output Coordinate Class: Select the feature class to be created, i.e., FreshWater1 
> SAVE > OK 

 
Refer to Table 1 in Appendix B for a summary the tools used to align coordinate systems 
between data files, make a shapefile from an Excel file, create a network data set, and clip areas 
of interest.  
!
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3.2.10 Finding Shortest Distance Paths between Facilities and Incidents 
The next step is to find the shortest path between the incidents (wells) and facilities (water 
sources, quarries, disposal sites, etc.). The definition of incidents in ArcGIS is the location that 
requires service.  Facilities, on the other hand, serve the incidents. Running the tool will generate 
the route assignments that will have specific ESAL values added to identify the locations of 
heavy loadings. A guide on how to use the Closest Facility function for quarries linked to oil 
wells for the first period follows. 

On the Network Analyst Toolbar,   (See 
section 3.2.7 where the toolbar was activated.) click on the black arrow near Network Analyst 
and choose New Closest Facility. In the Network Analyst Window,  

> Right click on Facilities > Load locations… > Load from: Select the file containing 
facilities of interest, i.e., Quarries).  

Make sure Location Position is set to “Use Geometry”. Define the radius tolerance for the 
facility search. In this case, the radius was set to 10 miles, to connect the facility to the nearest 
network lines within a 10 mile radius.  

> Click OK to load facilities.  
The same method can be followed to load the OilWells as incidents. Now the facilities and 
incidents locations are loaded.  

Click on the Solve button  in the Network Analyst Toolbar to find the shortest 
paths. Figure 3.4 displays the output of the Network Analyst Tool with the shortest routes 
between quarries and oil wells (1st period only).  

!

!

Figure 3.4 Network Analyst Quarry to Oil Wells Output  
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The previous steps will need to be repeated for each individual route type, i.e. Quarry to 
Oil Wells, Disposal to Oil Wells, Water source to Oil Wells. The Texas Study used six different 
routes for the analysis. The routes were specific to the data available and the time period in 
question. 

3.2.11 Adding ESAL Values to Each Route Type 
Each route has different ESAL values. Adding an ESAL value field in each route’s attribute table 
is crucial to quantifying the damage and for further analysis. The instructions below show how to 
add ESAL values for each route. This step must precede the steps in sections 3.2.12, 3.2.13, and 
3.2.14. 

In the main toolbar under the Window tab, select Table of Contents.  
> Right click on Routes > Data > Export Data… > and name each route accordingly.  

Repeat for each route type, i.e., Quarry_to_Oil_Wells.  
> Right click on the file name created, i.e. Quarry_to_Oil_Wells   
> Open Attribute Table > Click Table Options dropdown arrow  > Add field… > 
Name field ESAL > Under Type select Double (Double is used for numerical values) > 
OK  
> Right click on the ESAL column > Field Calculator > Type in calculated ESAL 
loading value for the route type, i.e. 686 (for Quarry routes), in the “ESAL=” open box.  

3.2.12 Interpreting Loading on Segments by Segments Type  
Various tools in ArcGIS can be used to classify routes in order of importance to determine where 
the highest ESAL loading will occur. This tool arranges ESAL loading by route type and 
represents the damage on each route proportional to width of the line. For example, Water well 
to Oil well routes have had the highest ESAL loading of 3640 per route. Line size of 8 was used 
for these routes. The second highest ESAL loading is Disposal well to Oil Well routes that have 
an ESAL loading of 1456 per route. Lines size 6 was used for this route, leaving Quarry to Oil 
well route assigned a line size of 4 to represent 686 as the ESAL loading value. Figure 3.5 shows 
the breakdown of routes layered. Different colors were assigned for each route to make 
visualization easier. Figure 3.5 shows what the model looks like with this method for identifying 
shortest paths.  

!
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Figure 3.5 All Shortest Path Routes Between Incidents and Facilities 
 

To clarify the results, the first step is to eliminate routes that are not relevant. For 
example, a tool in ArcGIS allows the user to eliminate routes with one trip only. The “Intersect” 
tool will generate an output that contains intersected trip routes. This means if there is only one 
trip in a specific route that does not intersect with any other trip route, this trip was eliminated. 
Running the tool will help to eliminate areas that are not of concern. Before beginning this 
analysis, refer to the steps in Section 3.2.11.  

To get to Toolboxes, click on the Window tab in the main bar and select Catalog from 
the dropdown menu. Click on the + next to Toolboxes, then 
 > Analysis Tools > Overlay > Intersect 
A window will pop up with green dots next to the files that must be input. The following was 
used for the Texas Study, 

Input features: Select the feature layer for intersection computation 
Output: Select the file and Name location for output feature class  
> OK 

Figure 3.6 shows the output of running the Intersect tool on QO routes. 
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Figure 3.6 Quarry Routes with Two or More Trips Involved 
 

Running the other five routes on the same tool will eliminate all other smaller loading 
paths. Figure 3.7 shows the final output before manually analyzing each county in the Austin 
District. The model now contains only routes with two or more trips in each route. 

 

!

Figure 3.7 All Routes with Two or More Trips Overlapping on the Same Route 
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Between Figure 3.7 to Figure 3.5, there is a significant reduction in the number of routes 
shown. This reduction is helpful at this point before analyzing each route since it saves time for 
model users. Further visual inspection of each county is needed to determine which routes seem 
important enough to calculate their ESAL values. The first step is to divide the analysis area by 
county and then follow simple steps to eliminate or examine routes. Rules of thumb for this 
analysis include the fact that Water to Oil Well routes carry 3640 ESALs which is more 
damaging than 5 Quarry to Oil Wells trips, given that Quarry to Oil Wells carry 686 ESALs, and 
2 Disposal to Oil Well trips will experience 1456 ESALs. Since we already eliminated routes 
with 1 Water to Oil Well trip and we only included 2 or more Water to Oil Well trips, then any 
routes with 10 Quarry to Oil Wells trips or 4 Disposal to Oil Well trips are automatically not as 
important as well. 

Each route should be investigated individually by zooming in on the route and selecting 
the attribute tables for each route type, and manually calculating ESAL loading in the segment 
by multiplying the ESAL number by the number of trips on the segment.  
By manually selecting a segment and opening the attribute table, a number of selected features 
will appear in the lower part of the table indicating the number of trips. 

3.2.13 Interpreting Loading Density on Segments 
This particular section shows the user how to quickly qualitatively identify critical segments. The 
output from this method is a graded route indicating high or low loading density. This method 
does not provide actual total ESAL damage values, but it does interpret the values the user inputs 
(See Section 3.2.11). This analysis requires the Extension called Spatial Analyst. The 
extension, just like the Network Analyst, must be activated before the analysis is made. Before 
beginning this analysis, refer to the steps in Section 3.2.11.  
The first step is to activate the network analyst extension:  

In main window top bar, click  
> Customize > Extensions… > Click on Spatial Analyst to activate it.  

The first step is to find the line density in each of the routes. According to ArcGIS resource 
center, the line density tool calculates polyline feature density by multiplying the line length by 
the “Population field” and dividing it by the area of grid cells (Figure 3.8). Usually the grid cells 
areas are set by default for lines generated by the network analyst outputs. So the variables here 
are “Population field” and length of line.  
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Figure 3.8 Density Line Tool  
(Source: ArcGIS Resource Center 2011) 

 
ESALs is the variable used as the “Population Field” to generate how many repetitive 

ESALs are applied to each segment in comparison to the rest of the route segments. The tool 
calculates length of the line spatially. An example of running the Density tool for the Quarry to 
Oil routes is illustrated in Figure 3.9 below.  

 
Spatial Analyst is activated under Toolboxes. Click on the Window tab in the main bar 

and select Catalog from the dropdown menu. Click on the + next to Toolboxes, then 
  System Toolboxes> Spatial Analyst Tools > Density > Line Density 
A window will pop up with green dots next to the files that must be input. The following was 
used for the Texas Study, 

Input Polyline features: Input line features for which to calculate density, i.e. Quarry to 
Oil well 
Population field: Select the calculated value, i.e. ESAL 
Output raster: Type in file name to output line density 
> OK 

Figure 3.9 gives the variation of the density of ESAL values associated with Quarry to Oil 
routes. 
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Figure 3.9 Quarry to Oil Routes: ESAL Density 

 
The output shows the ESAL density values as black when it is high, white when it is low. 

Running the density line tool for the remaining 5 routes will generate 5 separate outputs. At this 
point we have multiple areas of concern for each route. The next step is to join all the outputs 
into one single output that shows the general areas of concern.  

The Weighted Sum Tool joins all the routes into one output by combining multiple 
raster inputs. The output will show the sum of inputs depending on their ESAL values 
importance from high to low.  

Click on the Window tab in the main bar and select Catalog from the dropdown menu. 
Click on the + next to Toolboxes, then 
  System Toolboxes> Spatial Analyst Tools > Overlay > Weighted Sum 
A window will pop up with green dots next to the files that must be input. The following was 
used for the Texas Study, 
Input Polyline features: Select all rasters representing previously generated routes 
Output raster: Name the output raster for the weighted sum 
  > OK  
Figure 3.10 shows the combined loadings as high or low density values through the use of the 
weighted sum function in Lee County. In the Texas Study, Lee County was where most of the 
fracking activity was located.  
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Figure 3.10 All Routes ESAL Density 
 

This output helps locate areas of high damage through quick visual inspection and agrees 
well with the results from Section 3.2.12, where ESAL damage analysis was first introduced. 
However, these two methods can work jointly depending on the choice of the user.  

3.2.14 Interpreting Total Loading Ranges on Segments 
The third technique identifies the damage locations by providing a hierarchy of important 
segments based on ESAL values. Before beginning this analysis, refer to the steps in Section 
3.2.11.  
The first step is to merge all the routes into a single file.  

To get to the Merge tool:  
Click on the Window tab in the main bar and select Catalog from the dropdown menu. Click on 
the + next to Toolboxes, then 

> System Toolboxes > Data Management Tools > General > Merge  
Input Datasets:  Input all the routes individually to be merged  
Output Dataset: Name the dataset where all routes will be merged, i.e. All_Routes 
> OK 

After merging the routes, the user should create endpoints. This will help identify where routes 
start and end on the merged network of routes. Naming this output “All_Routes_EndPoints” is 
recommended, since the model will require more shapefiles.  
Click on the Window tab in the main bar and select Catalog from the dropdown menu. Click on 
the + next to Toolboxes, then 

> System Toolboxes > Data Management Tools > Features > Feature Vertices to 
Points 
Input Features: Input the merged file, i.e. All_Routes 
Output Feature Class: Name the feature class, i.e. All_Routes_EndPoints 
> OK 
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In the “All_Routes” merged file, use the “dissolve” tool to create a single base route for the 
purpose of combining layered routes and determining associated loadings.  
Click on the Window tab in the main bar and select Catalog from the dropdown menu. Click on 
the + next to Toolboxes, then 

> System Toolboxes > Data Management Tools > Generalization > Dissolve 
Input Features: Input the merged file, i.e. All_Routes 
Output Feature Class: Name the feature class, i.e. All_Routes_Diss 
> OK 

 
A tool that splits line based on points is called “Split line at point”. The generated file will have 
spatial segments where the routes are intersecting and contain the single trip routes. These split 
routes are used to calculate how many trips are using each segment and what ESAL values are 
associated with each.  
Click on the Window tab in the main bar and select Catalog from the dropdown menu. Click on 
the + next to Toolboxes, then 

> System Toolboxes > Data Management Tools > Features > Split Line at Point 
Input Features: Input the dissolved route file, i.e. All_Routes_Diss 
Point Features: Input route start and end points, i.e. All_Routes_EndPoints 
Output Feature Class: Name the feature class, i.e. All_Routes_Split 
> OK 

 
The next step is to spatially join each route to the split route file to calculate the total ESALs in 
each segment. Within the Texas Study, there were six different routes (water to oil well, quarry 
to oil well, disposal to oil well, etc.).  
In the main toolbar under the Window tab, select Table of Contents. Right click on the split 
route file, i.e. All_Routes_Split  

> Join and Relates > Join…  
The window will read “What do you want to join to this layer?” Select Join data from 
another layer based on spatial location 
The window asks to “Choose the layer to join to this layer, or load spatial data from 
disk”: Select a route to join (eventually all routes will be joined back into the model), i.e. 
Quarry 
> Check the Sum box under “How do you want the attributes to be summarized?” 

Figure 3.11 shows the window and what options to choose to spatially join the routes. 
!
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Figure 3.11 Join Data Window Inputs 
 

The output file is automatically named “Join_Output” and does not need to be renamed. The next 
step is joining every file spatially, which will automatically be output as “Join_Output2”. Repeat 
until the second to last route file is joined to All_Routes_Split. 
For the last file under the question, “Specify output shapefile or feature class for this new layer:” 
type in Total_ESAL. 
 

The last step is to add a field in the attribute table for the total ESALs, which in this case 
was named “Total_ESAL”.  

> Right click “Total_ESAL” > Open Attribute Table > Right Click on the ESAL 
column  > Select Field Calculator… > Yes  
Now refer to Figure 3.12 to complete the calculation. 
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Figure 3.12 Field Calculator Window Inputs 

 
Figure 3.13 shows the total loading damage for the routes in the Texas Study. Each line thickness 
corresponds to a range of ESAL damage. 

 
Figure 3.13 Final output showing exact ESAL numbers on each route 
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3.3 Discussion 
This model predicts truck trips and associated ESAL values for specific highways resulting from 
increased hydraulic fracturing activities. The model output identifies routes that represent the 
truck travel routes and ESALs. Different trip purposes and trips traveling in different directions 
are overlapped in the model. The ArcGIS model provides the tools for users to build the desired 
analysis. Note that before beginning an analysis method, ESAL values must be added to the 
routes (See Section 3.2.11). A summary of the three model building options follows: 

Interpreting Loading on Segments by Segments Type: This method shows all the 
routes in the model with each route assigned a specific width and color, meaning that each route 
is associated with a specific ESAL value. This analysis method is basic and does not require 
extensive knowledge or software skills. The output of this method can be interoperated by 
manually adding each overlapping route’s ESAL value to find the sum for the intersected 
segment.  

Interpreting Loading Density on Segments: This analysis method allows the user to 
identify “critical” segments on the fly. This is based on spatial analysis of ESALS of overlapping 
routes that have high total numbers of ESALs. The method is ideal for users with moderate 
knowledge of the software, and provides an efficient way to manually add fewer segments and 
only focus on critical zones.  

Interpreting Total Loading Ranges on Segments: Although this analysis method can 
be difficult for the user to implement in the software, it provides exact numbers of ESAL values 
from the first run. It is the most efficient process. It does not take into account the effects of the 
variation in ESAL values and it automatically sums overlapping ESALS and single trip route 
ESALS.  

3.4 Early Warning System (ESW): The Austin District Model 
The Early Warning System model was developed to predict unusual truck impacts on low 
volume pavement as a result of land use changes. Various studies have generated tools and 
methods to save money on pavement maintenance. Typically, land use changes generate new 
truck traffic associated with the construction and production activities, such as hydraulic 
fracturing.   

This study describes a system for anticipation of land-use changes related to the Oil and 
Gas Industry utilizing permit data including oil, natural gas, and water disposal permits.  In 2013, 
the United States has seen a huge increase of newly drilled wells being hydraulically fractured 
(up to 95%). These wells make up on average 43% of oil and 67% of natural gas production, a 
significant portion of new well development (DOE, 2013). Information on distribution centers 
and storage locations are used as additional destinations while equipment and raw material 
sources, such as water wells and quarries, are utilized as origins for truck travel.  Using this 
information along with a shortest path algorithm, expected system loading can be determined. 
Data on road characteristics like road functional classification, shoulder status, and pavement 
conditions can be used to further determine the risk for pavement failure. The tool identifies and 
prioritizes specific pavement sections in terms of expected pavement loading and uses a 
Geographic Information System (GIS) to graphically present results.  

Identifying pavement sections with expected increases in truck traffic loading can ensure 
proactive maintenance. Widespread application of hydraulic fracturing by petroleum drillers has 
generated large numbers of heavy trucks that are often concentrated on low volume roads that 



 33 

have thin pavement structures.  Without key pieces of information about truck origins and 
destinations, it is hard to prioritize which low volume roads will require timely pavement 
strengthening.   

The developed Early Warning System (EWS) is illustrated through a case study in the 
Austin TxDOT District area that includes three primary counties, namely, Caldwell, Bastrop, and 
Lee counties. Heavy activity in the Eagle Ford Shale, which follows nearly the same alignment 
as Interstate 35 approximately 500 miles to the East of Austin, has led to increased truck traffic 
on the main interstate and low volume roads important to the population in the district area. 
Issued drilling permits plummeted in 2015 (Figure 3.14), indicating the plateauing of new 
drilling activity.  

 
Figure 3.14 Texas Eagle Ford Shale Drilling Permits Issued 

(Source: Texas Railroad Commission, 2016) 
 

However, many people in the energy industry expect a spike to occur sometime in 2017. The Oil 
and Gas Industry is cyclical, therefore peaks and troughs in new activity are not usual.  

3.5 Early Warning System (EWS) Framework      
The EWS Framework outlines a step-by-step process for creating and maintaining a program for 
advanced warning pavement maintenance. This system is illustrated in Figure 3.15 and explained 
in following sections.  
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Figure 3.15 EWS Framework 

3.6 Truck Trip Generation 
For this study, data samples from three Texas counties, Caldwell, Bastrop, and Lee counties were 
used.  Locations and approval dates of oil drilling permits and active saltwater disposal well 
information was gathered from the Texas Railroad Commission (RRC). The sample data 
extracted from the RRC included information on 26 oil wells. The start date for drilling was 
determined from information on FracFocus.org, and the average time from approval to drilling 
start was calculated to average around 50 days. Well depths ranged from 1,975 feet to 8,700 feet 
and water requirements ranged from approximately 157,962 gallons to over 9,232,230 gallons. 
Although both horizontal fracking and vertical drilling permits were issued, most wells in the 
sample used horizontal fracking methods. More water is required for horizontal fracking, which 
averages 5,943,105 gallons per well, whereas vertical drilling averaged about 1,389,803 gallons 
per well. This is because horizontally fracked wells drill to the depth of the formation and then 
turn 90 degrees to penetrate and break up gas or oil along a shale seam, requiring significantly 
more fluid than traditional vertical wells. Often, multiple horizontal “arms” will be drilled from 
one location. This method of drilling can occur either with one permit or by coming back to an 
old already drilled well and “re-fracturing” it. An important factor to consider is the quantity of 
sand used in fracking for each well. According to the sample data, 13.2% of the total fracking 
fluid mass is sand.  

3.7 Comparison of Horizontal Fracking and Vertical Drilling Traffic 
Water transportation dominates the loading during the well construction process. Generally, 
flowback water is about 20-50 percent of the actual volume used in the fracking injection 
process. For the purpose of this study, a conservative assumption of 40 percent was made in 
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determining the volume of flowback water during the construction phase. After the initial well 
completion, saltwater produced continues requiring off-site transportation. A dramatic change in 
truck traffic occurs during the first two weeks of drilling. Typical daily truck traffic after drilling 
would be 2-3 trips per day.  This information indicates water truck traffic is most prominent as 
the drilling process begins, but then diminishes rapidly over time (See Section 2.7, Figure 2.5). 
This emphasizes our urgency in delivering prioritized pavement maintenance information, as 
most of the associated damage occurs in the first few weeks of drilling. 

Transporting sand and gravel to the well site is a small, yet significant component. Gravel 
is mostly used to build access roads in the vicinity of the well site. Large heavy trucks are 
necessary for transporting the hydraulic fracturing equipment to the site.  Although the truck size 
and weights are often extreme, the number of passes of each truck is small, which contributes a 
small percentage of ESAL loading compared to the overall traffic. This truck loading 
information was therefore excluded from this study due to the difficult nature of tracking or 
obtaining the information for Oversize/Overweight vehicle permits and their pre-determined 
paths.  Table 3.1 shows a summary of truck trip generation and the equivalent single axle load 
(ESAL) applications expected for the construction of a typical horizontally fracked well in the 
Eagle Ford Shale area. 

Table 3.1: ESALs for Truck Trip Generation 
 
 
 

 

3.8 Predicting Truck Paths 
The locations of drilling sites, source water wells, disposal wells, and quarries are origin and 
destination inputs for the model to determine truck paths. In Texas, the RRC monitors the 
approval process for oil and gas drilling permits so the RRC online website provided well permit 
locations, date of request, and date of approval (if already approved).  Two time periods from the 
year 2014 were selected: June 1st to August 31st and September 1st to November 30th. In addition, 
the RRC provided information on the active saltwater disposal wells in the region.  

Microsoft Excel was used as the main method for data input, while Shapefiles were used 
when available. Excel tables described locations of wells for Lee, Caldwell, and Bastrop counties 

Construction Activity per Well 

Purpose Full 
Weight 

Single Axle 2 Tandem 
Axles 

ESAL 
(Value) 

# of 
Trucks 

ESALs 

Water 80Kips 12Kips 0.229 34Kips 2.22 2.449 1486 3639 

Water 
Disposal 

80Kips 12Kips 0.229 34Kips 2.22 2.449 594 1456 

Bulk Sand 80Kips 12Kips 0.229 34Kips 2.22 2.449 200 490 

Gravel 80Kips 12Kips 0.229 34Kips 2.22 2.449 80 196 

Equipment / 
Other 

80Kips 12Kips 0.229 34Kips 2.22 2.449 200 490 

Total            2,560 6271 
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and later extended to include the Burleson, Fayette, Gonzales, Guadalupe, Milam and 
Washington counties. Locations for saltwater disposal were also described in Excel format. In 
addition, source water locations obtained from the Texas Commission on Environmental Quality 
(TCEQ) were obtained as Shapefiles downloaded from the website.  TCEQ maintains datasets as 
Shapefiles that include “Public Water System Wells & Surface Water Intakes.” This particular 
Shapefile gives the locations of water wells that are most useful for the fracking process, and 
specifically marks the use of and ownership of each well, easily identified by company name.  
Lastly, TxDOT provided active quarry coordinates supplying sand and gravel for the Austin 
TxDOT District Area.   

3.9 GIS Mapping Tool 
The purpose of this project was to develop a graphically based model that forecasts accelerated 
changes in truck traffic pavement loading. For the Oil and Gas Industry, well activity and its 
associated locations, along with road network specifications, were combined using ArcGIS 
software. With periodic updates, the model can better identify road segments likely to experience 
significantly accelerated loading. All data sources are easy to access and ArcGIS provides an 
easily visualized answer to accelerated loading questions. With an average time of 50 days from 
well permit application to well permit approval, and some time required for mobilization to the 
drilling site and preparation of gravel roads to the well pad, a significant amount of advance 
warning can be given for pavement maintenance systems. While it is optimistic to think that 
agencies can design, plan, and mobilize in this timeframe, it will still allow for lead time on 
projects that would otherwise go unnoticed until failure was observed. 

Regarding implementation of the EWS, the responsible pavement maintenance manager 
for a state DOT District or County can utilize the identification of the heavily impacted roads to 
prioritize maintenance activity. This will require monthly evaluation of the EWS to determine 
where the maintenance budget can best be spent. A treatment matrix based on roadway 
functional classification and soil type for each affected section could be developed to allow for 
easy and quick treatment choices. In addition, this tool can be used to evaluate the approximate 
percentage of life cycle loss due to extreme loading from fracking activity, which could form a 
basis for pro-rata or roughly proportional cost sharing, to be paid by drilling entities. 

ArcGIS was used to visualize the information retrieved for use in determining truck 
travel paths. Locations were exported as Shapefiles into ArcGIS providing an easily interpreted 
model that can be easily updated. The RRC oil well permit data and the water well locations can 
be updated using Shapefiles from TCEQ. Disposal well sites can be checked periodically for 
changes, but these sites are unlikely to change frequently. Likewise, quarry locations have only a 
small probability for location changes. Thus, only new oil well and water source sites would 
need to be updated periodically to maintain the model. 

The next step after importing well, quarry, and other location data into ArcGIS was 
adding road network information. The Djikstra algorithm used in the Closest Facility 
functionality helped to connect trip origins and destinations forming likely truck paths.  Running 
the complete network generates route assignments for trucks associated with all material 
deliveries to the drilling sites and disposal of water from the sites. Equipment delivery, oil and 
gas extraction, and delivery to storage and distribution sites were excluded. 



 37 

3.10 The Model 
The ArcGIS model consists of oil wells, water wells, quarry locations, disposal wells and 
estimated truck traffic associated with the permitted drilling activities. Minimum distance paths 
were identified to connect origins and destinations. Figure 3.16 shows the graphical route model 
with all routes identified by activity. 

 To evaluate pavement loading associated with truck routes, Equivalent Single Axle 
Loads (ESALs) are used. The model uses different line thicknesses and colors to represent 
varying magnitudes of ESALs. Figure 3.17 presents the model of routes with 2 or more trips 
between facilities and incidents. At this stage, the model only includes major road segments with 
higher truck volumes.  
 

 
Figure 3.16 Model with All Routes by Activity 
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Figure 3.17 Model with Routes Containing 2 or More Trips 

 
To prepare the model, the average amount of water, fluid composition, and flow back rate 

were all assumed to be the same for each well, with the total number of ESALs associated with 
each trip type provided in Table 3.1. The routes in this model descend in importance based on 
ESAL loading. The finished model describes which road segments are experiencing more than 
expected loading so that officials can develop priorities for pavement strengthening.  
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Chapter 4.  Implementing Network Monitoring in Tamaulipas 

4.1 Improving Roads and Road Safety  
Because of the anticipated increase in hydraulic fracturing in Tamaulipas, engineers 

should carefully evaluate roadways to determine if they are sufficient to withstand heavy, 
frequent truck travel. Given the water, aggregates, and other resources being carried to and from 
wells, roads can experience an unusual amount of wear in a short amount of time. It is important 
to consider the potential damages that can result from the usual loadings. As a preventative 
measure, pavement reinforcement in areas where roads are likely to see more truck traffic can 
help save money and resources required compared to rebuilding roads from scratch. The 
reinforcement on pavement in Tamaulipas will allow for safer, smoother travel in areas where 
great damage would have likely occurred.  

Hydraulic fracturing has been a concern within the municipality of Tamaulipas and CNH 
has historically controlled the permitting of drilling sites. With the likelihood of increased 
fracking activities, an energy forum has been formed in Tamaulipas to ensure positive economic 
development. Development of infrastructure in Tamaulipas should allow the state to reach its 
potential for transporting goods and services. 
 

4.2 Background  
So far, only a few unconventional test wells have been drilled in the State of Tamaulipas. These 
test sites are located in the northern part of the State where conventional drilling has been 
permitted and where fracking operations are expected to boom. As more lease blocks are 
awarded, more hydraulic fracturing is likely to occur in the State of Tamaulipas. At this time, 
Pemex operates several oil and gas sites and may promote installation of various wells within the 
State (Haahr, 2015). However, as a result of the Energy Reform, the industry has the opportunity 
to expand internationally for the first time. 

While there are many benefits to the hydraulic fracturing in Tamaulipas, Mexico, there 
are infrastructural concerns that require special attention. Studies carried out for Texas have 
shown hydraulic fracturing to have a serious impact on roads. When transporting water, the 
weight or load carried on a roadway can cause dramatic negative effects on the pavement over 
relatively short periods of time.  

Fortunately, inexpensive pavement strengthening can prevent major damage caused by 
the frequent truck trips. Although trucks carrying large quantities of water to and from the 
drilling sites have the potential to cause severe damage to roads, measures can to be taken to 
prevent serious pavement damage consequences. In order to most effectively prevent damage, 
planners need forecasting tools to determine how much damage can potentially occur on any 
given road used for hydraulic fracturing activities. 

Recent studies performed at the University of Texas at Austin have analyzed hydraulic 
fracturing areas in Texas counties to determine potential road damage locations. Information 
about the road network, well locations, water source and water disposal sites was used to predict 
routes that will likely experience unusual heavy truck traffic. Additionally, these studies have 
estimated the number of heavy truck trips required per well to transport the typical amounts of 
water, sand, aggregates, and disposal water needed for the hydraulic fracturing process.  
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The process of hydraulic fracturing requires many trucks to transport all of the necessary 
materials including water, aggregate and heavy equipment to the well locations. These heavy 
trucks can cause accelerated wear on pavement surfaces.  Typical 18-wheelers weighing up to 
100,000 pounds (~43,560 kg) can make thousands of trips to and from well sites throughout the 
construction period. This magnitude of truck traffic can literally destroy thin light duty 
pavements that have been designed for light loadings.  

The majority of the truck trips for a typical well site carry fluids. The truckloads vary 
anywhere between 400 to 600 tanker trucks full of fluid. In addition, trucks will carry anywhere 
from 2.4 to 7.8 million gallons of water per well (Leff, 2009). The volume of chemicals used for 
preparation of fracking fluids will be in the thousands of gallons. 

Furthermore, the flowback water or wastewater that comes out of a well during fracking 
must be hauled away as industrial waste. The flowback water that comes out of the well is 
contaminated with various chemicals and radium. This loading for the wastewater will be in the 
range of 200 to 300 tanker loads (Leff, 2009). The industrial fracked wastewater should be 
disposed of properly at either a remote disposal area or at a processing facility. It is important to 
identify the area where wastewater will be sent after the fracking process since this route will 
experience the second largest pavement loading after the source water to well route.  

The maximum legal weight is key to determining the number of truck trips needed per 
each route type (water to well, aggregate to well, well to disposal site, etc.). The number truck 
trips in the Texas study were determined by dividing the weight of the total material transported 
per average well by the maximum legal truck weight. The maximum legal truck weight in the 
U.S. is 80,000 pounds (~3.6,287 kg). This weight standard can change depending on road 
regulations, but it is rarely exceeded in a given trip unless granted a special permit.  

Frequent truck travel with heavy loads during hydraulic fracturing activities can cause 
great damage, reducing the durability of roads and having a negative impact on roadway safety. 
Trucks carrying heavy resources can cause tremendous damage to pavement. Thousands of trips 
are made to and from just one well during fracking activities. More damage can occur in a week 
of carrying loads to hydraulic fracturing sites than seen in over a year’s worth of normal 
everyday truck travel.  

4.3 Pavement Standards 
Currently, the U.S. federal weight limit on Interstate Highways and bridges suggest no more than 
a gross vehicle weight limit (GVW) cap of 80,000 pounds of which 20,000 pounds is designated 
as the maximum for a single-axle and 34,000 pounds as the maximum for tandem-axle loadings. 
For the purpose of this assessment, the gross vehicle weight limit of 100,000 pounds (43.6 metric 
tons) will be used to determine the effects of pavement within the area of Tamaulipas.  

Maximum truck size and weight limits vary in Mexico with changes in the economy or 
benefits from using larger and heavier trucks. The current maximums depend primarily on 
highway classification and vehicle axle configuration. With special permits, trucks can be given 
access to specific areas and connecting highways.  

Understandably, states bordering Mexico are concerned with excessive weight limits. It is 
important to keep roads safe and infrastructure operating. The federal government in Mexico 
through the Secretaría de Comunicaciones Y Transportes (SCT), which is the Ministry of 
Communication and Transportation, helps manage size and weight regulations for trucks on 
highways (Hodges, 2011). As noted through the National Cooperative Highway Research 
Program, legal truck loads are based on certain limits.  
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Four Federal Weight Limits exist for the United States (TRB, 2007): 
1. 20,000 lbs for single2 axles 
2. 34,000 lbs for tandem3 axles 
3. A maximum GVW4 of 80,000 lbs, and 
4. Application of the FBF B for each axle group up to the maximum GVW.  
 

In studying the traffic and behavior along roadways, trucks in the U.S. and in Mexico are 
of similar size and composition. However, legal limits differ with the gross vehicle weight 
(GVW). For a common truck configuration (T3-S2), Mexico considers a maximum of 
approximately 46.5 metric tons (102,515 lb.), when driver, vehicle, and carrier comply with all 
exception requirements (Hedges al et. 2011). In considering the truck configuration differences 
between Mexico and the United States, the research proposed justifies using the truck 
configuration of 100,000 pound loading (See Figure 4.1).  
 

 

Figure 4.1 3-S2 Truck Configuration and ESAL Loading, Proposed Maximum 
 

Specifically, Mexican truck weight regulations apply to commercial vehicles using federal 
highways, and these standards must comply with the requirements for maximum weight per axle 
loading. In obtaining an additional axle, trucks will decrease the impact of the load on pavement.  

Furthermore, determining pavement strength for paved roads in Mexico can assist in 
estimating the anticipated damage. The structural strength of the pavement is based on the type 
and thickness of each structured pavement layer. The Structural Number (SN), a measure of the 
overall required structural design in sustaining traffic loading, can express this overall strength. 
As experimented by the American Association of State Highway and Transportation Officials 
(AASHTO) in the AASHO Road Test, pavement structure relates serviceability, traffic, and 
thickness in pavement to pavement performance. In choosing the appropriate structural number 
(SN) for Mexico, the most cost-effective design was decided through trial and error. The 
Structural Number is used to indicate layer thickness, and it represents the relative strength in 
materials being used during the construction of pavement (AASHTO 1993).  By assumption, 
                                                
 
2 Single Axle Weight – the total weight on one or more axles whose centers are not more than 40 inches apart. The 
federal single-axle weight limit on the Interstate System is 20,000 lbs. 
3 Tandem-Axle Weight – the total weight on two or more consecutive axles more than 40 in., but not more than 96 in. 
apart. The federal tandem-axle weight limit on the Interstate System is 34,000 lbs.  
4 Gross Weight – the weight of a vehicle or vehicle combination and any load therein. The federal gross weight limit 
on the Interstate System is 80,000 lbs. 
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Structural Number = 3 will be used to model the pavement strength. In flexible pavement 
designs, ESAL values are independent of the structural number. A higher SN means a stronger 
pavement type, thus the impact of traffic on a pavement surface decreases with stronger 
pavements. Paved roads are indicated by a high structural number with stronger pavement (6) 
whereas unpaved roads have a low structural number with destructible pavement (1). The 
objective in road design accordance with the AASHTO methods is to find a flexible pavement 
Structural Number (SN) able to support the projected ESAL value for the pavement life. If the 
ESAL value for roads in Mexico is constant, an estimated thickness can be formulated to make 
sure pavement will survive.  

For flexible pavement design, pavement performance is measured based on its structural 
and functional ability to be serviced given the Present Serviceability Index (PSI) scaling 
anywhere from 0 to 5. Traffic is modeled in terms of expected ESALs and the terminal PSI (pt = 
2.5) such that the pavement meets design standards. The calculation breakdown for expected 
ESALs is in Table 4.1. 

Table 4.1: ESAL Number Calculation for Different Weights in Tamaulipas 
ESAL Number Configuration 

Purpose Full Weights 
(lbs.) 

Single Axle (Kips) 2 Tandem Axles (Kips) ESAL 
(Value) 

Proposed, Max. 
Legal Limit 

100,000 16 0.646 42 4.98 5.626 

 

Trip generation tables and GIS data will be used to help characterize damage to pavement 
based on ESAL loadings along significant routes being traveled. This approach allows time and 
money to be saved when utilizing traditional techniques used in surveying traffic. Methods for 
estimating AASHTO Equivalent Single Axle Loads (ESALs) are easily accessible and can be 
used for the purposes of creating a visual model. Most methods of planning in urban areas and 
rural areas assume trucks to make up only a small fraction of the traffic, but even a small fraction 
of total traffic being composed of heavy trucks is significant and cannot be overlooked, 
especially when anticipating an increase in truck traffic due to hydraulically fractured wells.  

Table 4.2: Oil Well Construction Truck Trip Generation for Tamaulipas 
Construction Activity per Well 

Purpose Number of Trucks ESAL (Value) ESALs per well 
Water 1486 5.625 8359 

Water Disposal 594 5.625 3341 
Bulk Sand 200 5.625 1125 

Gravel 80 5.625 450 
Equipment / Other 200 5.625 1125 

Total 2560 5.625 14400 
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Table 4.3: Oil Well Production Truck Trip Generation for Tamaulipas 
 

Production Activity (Water Disposal) 
Purpose Number of Trucks ESAL (Value) ESALs per well 
1st week 476 5.625 2678 
2nd week 196 5.625 1103 

Up to 60 days 90 5.625 506 
After 60 days 30 5.625 169 
Haul Product 2 5.625 11 

Total 794 5.625 4466 
 

The production phase of a well is much less damaging than the construction phase. The ESAL 
values generated for the construction and production phases for a single oil well are summarized 
in Tables 4.2 and 4.3. The production phase results in smaller total ESAL values than the 
construction phase. The length of the production phase is very variable, lasting anywhere from a 
few years to some wells that have reached 50 years of production and are still operating. The 
production life of a well mainly depends on the formation. Moreover, with the construction 
phase only lasting as little as 13 days, the damage to the roads per well is not only much larger 
than the production phase, but also occurs in a shorter period of time. For a single 100,000 pound 
truck with a 16 Kip single axle = 0.646 ESALs and two tandem axles = 42 Kips each, the total 
ESAL damage per truck is 5.625. Now take the example of water operations during construction. 
The table states that 1,486 trucks carry water during well construction. Multiplying the number 
of trucks by the ESAL value of 5.625 for this particular truck configuration will give precisely 
8,359 ESALs.  

4.3.1 Empty Truck Trips 
During the process of hydraulic fracturing, many trips are taken to and from the well. Some of 
these trips will involve empty trucks having carried their load to the drilling site and then making 
their way back to retrieve more resources. As the case may be, these trucks also cause damage to 
the road surface. The roadway will be worn even after a few passes from incoming truck traffic. 
Through research and analysis, modeling techniques can be carried out to describe with a more 
accurate view how truck traffic will behave. The response of empty trucks during fracking 
activities may vary depending on the resource being carried. For example, the loading of a truck 
may be twice as heavy when carrying water than when empty. 

Truckloads for any given hydraulic fracturing process are considered not only a 
maximum allowed truck weight of 100,000 pounds but also an empty truck weight of 
approximately 40,000 pounds (Cambridge Systematics, 2007). Thus, the loaded trips along with 
the empty trucks trips need to be configured into the model for analysis to describe the real story 
of how roads are being impacted due to loading on the pavement’s surface. Accordingly, trucks 
may leave their destination with a full load and either empty upon return or full but carrying 
waste products. Therefore, this analysis will account for one full truck and one empty truck. For 
the movement of resources, it is important to address the estimation of empty truck trips and how 
these trips will cause damage to a road’s surface during loading. 
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Table 4.4: Truck Trip Generation for 3TS2 Empty Trucks 
ESAL Number Configuration 

Purpose 
Full 

Weights 
(lbs.) 

Single Axle (Kips) 2 Tandem Axles (Kips) ESAL 
(Value) 

Proposed 
Limit, Empty 

Truck 
40,000 12 0.229 14 0.042 0.313 

 
Empty truck trips will be taken into consideration when analyzing the amount of loading. Trucks 
trips can be utilized to represent a “sequential unloading, return empty” truck-trip pattern 
(Cambridge Systematics, 2007). As such, trucks may leave their origins with a full load of cargo, 
but after reaching their destination, the trucks will return empty having delivered the material 
being carried. Table 4.5 describes the ESAL values involved in one pass of a full truck and one 
pass of an empty truck on a road surface. These ESAL values will be used in the analysis to 
show all activity occurring during truck trips. 

Table 4.5: Revised5 Oil Well Construction Truck Trip Generation  
Construction Activity per Well 

Purpose Number of Trucks ESAL (Value) ESALs per well 
Water 1486 5.938 8824 

Water Disposal 594 5.938 3527 
Bulk Sand 200 5.938 1188 

Gravel 80 5.938 475 
Equipment / Other 200 5.938 1188 

Total 2560 5.938 15202 
 
Note: the construction process for a hydraulically fractured well is much more damaging than the 
production process. As such, this analysis only considers the construction phase. 

4.3.2 Available Road Network 
Tamaulipas has both roads that belong to the federal highway system and state system. The roads 
that belong to the federal highway system offer at least one lane in each direction. On the other 
hand, the types of roads under the state system are very variable, but most closely resemble the 
FM road system in the United States. Some of the roads under the state system are paved, while 
other roads are currently dirt roads. While federal funds are available for the maintenance of state 
roads, in the northern part of Tamaulipas, it is very expensive to build roads. Additionally, 
freight operations in general in the northern part of the state are also very expensive. 
                                                
 
5 Notice this generated truck trip analysis is the sum of the truck’s payload and the empty vehicle weight.   
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Tamaulipas has an extensive highway system involving interstate class facilities that have 
been modernized. Within the area, four-lane Highway 40 exists in the western part of the 
panhandle. This small segment of roadway connects Laredo, Monterrey, and Reynosa. This 
roadway has great significance, providing highway travel between Texas, Nuevo Leon, and 
Tamaulipas. Logistically, Tamaulipas has worked to upgrade its roadways to modern standards.  

In addition, the border area of Mexico shows roads that are a part of trade crossings that 
are being considered for upgrades. The South Texas-Mexico border region contains an important 
corridor for trade. The Rio Grande Valley is growing with respect to Mexican cities such as 
Nuevo Laredo, Reynosa, and Matamoros. Mexico is able to export crude oil products to the 
United States by use of the border crossings.  

The road network description acquired from Tamaulipas contained roads from both the 
federal and state highway system. A common problem with these road network files was 
unconnected segments. Unconnected segments may prevent all shortest paths between incidents 
and facilities from being found using Network Analyst. Unfortunately, an easy fix for this issue 
was not identified. The alternative was to manually connect hundreds of disconnected segments 
without information about functional road classification and accurate locations for the manual 
connectors.  
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Figure 4.2 Tamaulipas Road Network  
(Source: Tamaulipas 2015) 

 
For this study, a Shapefile from a reliable source (DIVA) was used to work around this 

issue. The main study area is situated along the border, which is an area that UT research has had 
extensive experience studying. The previous experience working with the road network along the 
border affirms that this source works well for this analysis. However, a fully connected network 
from Tamaulipas with functional class descriptions would be the best option. Other pieces of 
information such as length of segments, names of roads, numbers of lanes, shoulder widths, etc., 
could also help with providing a more complete picture for the model.  

4.3.3 Changing Infrastructure for Tamaulipas 
In Tamaulipas, the infrastructure is changing based on oil and gas production. One of the more 
profitable municipalities to extract oil and gas, Tamaulipas is highly regarded for its technically 
recoverable shale gas resources within the Eagle Ford Formation of the Burgos Basin. This 
portion of oil and gas production extends from the State of Texas. But with Mexico’s complex 
shale geology, the potential for development outside of the Burgos Basin is less certain.  

In part to prepare for increased development, roads in Tamaulipas are in the process of 
being modernized. The Tamaulipas government is taking action to improve highways. Pavement 
designs being developed in Mexico closely resemble global standard engineering compliances. 
Some current options in road paving involve using either asphalt or hydraulic concrete. Within 
the main intersections where heavy traffic is found, hydraulic concrete is often used to extend the 
average pavement life. For secondary roads and intersections with less traffic, asphalt is used 
more often for road base. Roadways are designed with the intention to have a minimum 2% 
transverse slope that provides runoff to the shoulders, to alleviate wear caused from settling 
moisture.  

Mexico’s pavement has experienced premature failures for asphalt pavement a short 
period of time after construction, as pavement is damaged by heavy truck traffic. To prevent 
rutting, protective layers must be applied so that the total pavement thickness is adequate for 
repeated heavy truck loading.  

4.4 Shale Oil and Gas Formations 
The structural framework of the geological provinces in Tamaulipas has been investigated by 
studying the regional variations in geologic petro-based well data. The gas production in the 
Burgos and Tampico Basin of northern Mexico is significantly increasing with the enhancement 
of operating resources. The area of Tamaulipas is developing an increased understanding of the 
potential reservoirs. Seismic data acquisition and processing allows geoscientists to characterize 
and interpret hydrocarbon accumulations. Figure 4.3 shows the extraction lease blocks along 
with the available 2D and 3D seismic imagery.  
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Figure 4.3 Map showing extraction lease blocks and seismic information.  

(Source: SENER 2015) 
 

The light gray lines are 2D seismic lines and the light gray blocks are areas with available 3D 
seismic data. The nominations for exploration areas offered during the Five Year Tender Plan 
were selected based on the 1) availability and quality of seismic data and 2) exploration potential 
(SENER, 2016). Considering the available seismic data, operators have the opportunity to better 
characterize the potential reservoirs.  
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Figure 4.4 Tectonic Elements of the Burgos Basin in the NW Margin of the Gulf of Mexico  
(Source: Hernandez-Mendoza, DeAngelo, Wawrzyniec, & Hentz, 2008) 

 
In general, the geological structure of Tamaulipas is considered to be complex, in part 

due to the Sierra Madre Occidental mountain range toward the west (Gary, 2010). This region of 
rock deposits is narrow and ridged compared to the Eagle Ford rock formations found in Texas 
(Figure 4.4). According to regional geological-geochemical studies assessing World energy, the 
Burgos Basin in northeastern Mexico contains some of the more recoverable respective resources 
since the Eagle Ford Shale Formation encompasses much of the area (2015). Thus, the Eagle 
Ford Formation, which runs through the U.S. and also through Mexico, indicates a region in 
productive and continuous mode (Figure 4.5).  
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Figure 4.5 Oil and Gas Shales in Mexico  
(Source Escalera Alcocer, 2013) 

 
As of late, oil provinces have been identified in this area of the Sabinas, Burro-Picachos, 

Tampico-Misantla, and Veracruz for their potential in discovering resourceful plays (USGS, 
2015). The Upper Jurassic and Upper Cretaceous shale formations appear to be overlapping 
within parts of the country where exploration is going to occur. These predictions of possible oil 
and gas fields were estimated due to the organic carbon and stratigraphic levels present in the 
formations.  

In Mexico, the locations of the oil and gas shales are pertinent to where drilling will take 
place. Overall, Pemex has spent approximately 75 years in exploration, recovering information 
based on the whereabouts of approximately more than 1,000 wells. This area of prospective 
drilling covers 120,000 km2 of land.  

4.5 Texas Study Comparison 
Heavy truck loading caused by land development or re-development may enhance pavement 
deterioration patterns. Unexpected heavy truck loading can accelerate pavement destruction. It 
costs about ten times more to repair pavement after it is destroyed than it costs to adequately 
strengthening pavement to carry the prospective heavy loading. Forecasting future at-risk 
pavement helps to avoid the costs of rebuilding completely destroyed pavements. Pavements 
experiencing severe traffic loading should be identified and strengthened. Each pavement type 
depends upon design, environmental influences, and potential traffic loading. Pavement 
structures can be reinforced before they fail by effectively anticipating increased truck loading.  

Pavement deterioration rates are strongly correlated to area weather conditions, the type 
of pavement experiencing the loading, and the amount of traffic on a given pavement. Land 
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development activities cause high truck traffic loading, especially on minor roads with weak 
pavement structures, where pavement destruction can occur at an augmented rate. 

The costs in pavement maintenance increase rapidly by several orders of magnitude as 
the added ESALs per mile increase. These costs are very dependent upon the quality of 
construction during the road construction process, the design pavement thickness, and seasonal 
weather/climatic conditions.   

4.5.1 Pavement Maintenance 
Maintaining pavement durability depends on data provided in annual reports on pavement 
historical conditions. With information on Tamaulipas road conditions taken into account, 
measures for improved maintenance and modifying pavement structure can ensure safer travel. 
Unexpected high traffic flow causes premature pavement damage. The practice of maintaining 
road durability differs across state and national borders. In Texas, the Texas Department of 
Transportation (TxDOT) has three categories for classifying possible maintenance: preventative, 
routine, and major maintenance. Each type of maintenance is described in accordance with their 
respective measures. Preventative maintenance prevents any major deterioration, routine 
maintenance delivers repairs, while major maintenance restores pavement that has been 
destroyed.  

Tamaulipas is divided into to municipalities (Figure 4.6), in which each municipality is in 
charge of its local streets. Municipalities have limited budgets, however, they are responsible for 
managing all public services. Public services include public lighting, solid waste management, 
and most importantly to this study, road maintenance. It might not be realistic to think that 
municipalities in Tamaulipas can design, plan, and mobilize in the timeframe between well 
permit application and well construction. However, the advanced knowledge will still allow for 
lead time on projects that would otherwise go unnoticed until failure was observed. 
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Figure 4.6 Burgos Basin Municipalities 
 

4.5.2 Studying Pavement Failure 
The American Association of State Highway Officials (AASHO) develops standards to build 
better, longer lasting roads. The equivalent axel concept introduced by AASHO expresses 
pavement damage due to one axle pass of any axle weight compared to damage done by one pass 
of a standard single axle (usually 18 kips). Equivalent single axles (ESALs) can be used to 
describe how trucks impact pavement. When looking at life-performance decrease in pavements, 
the biggest cause is overloading. At a non-linear rate, roads become damaged faster as heavier 
loading occurs. Rural roads specifically experience a greater impact due to loading by heavy 
truck traffic.  
Three common rural types can be defined (USDOT, 2012):  
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1.  Basic6 – where counties are dispersed and show no major population centers of 5,000 
or more  
2. Developed7 – where counties are located near major population centers of at least 
5,000 or more 
3. Urban Boundary Rural8 – where counties or regions lie along highly developed 
metropolitan areas 

4.5.3 Characterizing Truck Trips 
For planning purposes, small urban and rural areas factor trucks as only a fraction of road traffic. 
But in fact, trucks are a significant portion of roadway traffic and should not be overlooked. 
They are much heavier than regular vehicles, therefore the resources transported to and from 
wells by trucks can cause a significant pavement impact. Trucks also have an effect on 
congestion in urban and rural areas since one truck can take up the same space on the road as 
three individual cars.  

The road network is comprised of rural roads that are important to agricultural purposes 
and rural communities like the rural Federal-aid highway system. In a 1994 survey, local rural 
roads were identified as being of less than adequate condition. It is obvious that county roads 
will need attention in the future especially in smaller counties. Significant changes in traffic 
volumes may severely impact an area especially if the pavement is not suited for heavy loading.    

4.5.4 Obtaining Water Resources 
The main concern, as described in the chapter on the Texas experience, is the water that is 
transported to and from fracking sites. Water is a critical component for hydraulically fractured 
wells. The impact on roadways of transported water can be dramatic. Large volumes of water are 
used in the process of drilling; approximately 1,500 truck loads are needed per drilled well. The 
weight of 1,500 trucks transporting water traveling on a given roadway can cause years of 
damage in just a few days.  

Tamaulipas has been looking into identifying the best usable water source for hydraulic 
fracturing activity. The State aims to remain more energy efficient with their work by gaining 
support from the Border Environment Cooperation Commission (BECC). This agency helps 
enact plans for protecting the environment. With petroleum systems located around the northern 
portions of the state, special considerations are given to Nuevo Laredo, Reynosa, Rio Bravo, and 
Matamoros. Not to mention, Tamaulipas’ capital, Ciudad Victoria, is working to manage and 
reduce operating costs overtime (BECC, 2013).  

For now, the State Water Commission has determined that the best sources for water for 
fracking activities are wastewater treatment plants. Table 4.6 shows the latitude and longitude 

                                                
 
6 Basic rural areas traditionally are areas that tend to have few or no major population centers and transportation is 
characterized by “farm-to market” or localized rural roads. 
7 Developed rural areas are urbanized areas in a county where most of the land is undeveloped. These areas may 
have an increased need for forecasting since they may be inclined to grow rapidly. 
8 Urban boundary rural areas are located within the fringe of large urban areas. These urban boundary rural areas are 
characterized by economic growth and development. 
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locations of wastewater treatment plants in Tamaulipas. Figure 4.7 shows the locations of the 
water treatment plants in Tamaulipas on a map.  

Table 4.6: Locations of Waste Water Treatment Plants 
(Source: Tamaulipas, 2015) 

 
 
 
The header “Gasto” indicates the liters per second (lps) that each plant can produce. The 
treatment facilities at Nuevo Laredo and Reynosa have been identified as the top water source 
candidates as they can produce as least 1,000 lps, which is enough water for 30 perforations per 
week. The other reason that wastewater treatment plants are in general the most preferred source 
is that using treated water, rather than fresh water, does not compete with population and 
agricultural needs for fresh water.  
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Figure 4.7 Locations and Water Production Rates (lps) for Water Treatment Plants  

(Source: Tamaulipas, 2015) 

4.5.5 Process of Hydraulic Fracturing 
The Environmental Protection Agency issued a study explaining the five stages of the Hydraulic 
Fracturing Water Cycle (Figure 4.8). These steps show the proper guidelines for acquiring water, 
the types of chemicals mixed into water as additives, and the pressurized fluid used in fracturing. 
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Figure 4.8 Hydraulic Fracturing Water Cycle  
(Source: EPA, 2015) 

Stage One: Acquiring Usable Water 
• Large volumes of water, whether ground water or surface water, are necessary for the 

hydraulic fracturing process. 
• Drinking water resources can be impacted. 

o Quantity of water available may change. 
o Quality of drinking water may change. 

Stage Two: Mixing Chemicals into Water 
• Acquired water at well site will be combined with not only chemical additives, but also a 

type of proppant or sand to make hydraulic fluid. 
• Drinking water resources can be impacted. 

o On-site spills and/or leaks have the potential to contaminate surface or ground 
water. 

Stage Three: Injecting Fluid 
• Hydraulic fracturing fluid is pressurized and injected, creating cracks in the formation 

where oil and gas escape to be collected. 
• Drinking water resources can be impacted.  

o Hydraulic fracturing fluid may contaminate ground water due to inadequate 
construction of well. 

o Fracturing fluids may move from target formation through existing faults or 
depressions to drinking water aquifers. 

o Metals or other active materials underground left behind during fracturing 
activities may affect drinking water. 

Stage Four: Excess Water in Fracturing or Flowback  
• With the release in pressure, a combination of chemicals and natural substances 

including: water from formation, hydraulically fractured fluids, and natural gases, make 
their way up the well to be stored away. 

• Drinking water resources can be impacted. 
o Spills and leakage from storage may affect ground water. 
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Stage Five: Disposal and Treatment of Wastewater 
• The handling of wastewater requires either underground ejection, treatment by disposal, 

or recycling for future use. 
• Drinking water resources can be impacted. 

o Inadequately treating water may lead to contamination. 
o The interaction between contaminants and disinfectants may cause byproducts to 

be formed in facilities where treating drinking water. 
 

Recycling wastewater has become a method that many companies have implemented, 
rather than retrieving water from the ground or other surface water resources. Ultimately, 
groundwater is the supply of fresh water obtained beneath the earth’s surface that exists in 
aquifers. Aquifers supply fresh water to open wells and springs, and they act as a primary source 
for fresh water to the population and agriculture. On the other hand, surface water includes any 
water occurring naturally that is exposed to the atmosphere. Surface water quality and quantify 
varies between rivers, lakes, reservoirs, and other sources. Surface water is another source of 
potable water.  

4.5.6 Solutions for Storage  
Determining sufficient sources of large quantities groundwater for use in fracking activities can 
be a challenge. Recent technology has improved processes known as aquifer storage and 
recovery (ASR), where water is added to aquifers and retrieved when needed (Wagner, 2015). 
Using an aquifer for storage can protect water from evaporation.  

Furthermore, desalination of brackish groundwater is a subject of interest due to the 
excessive cost of water treatment. The thick layers within aquifers facilitate water desalination; 
the separated rock formations of low-permeability have no effect on stored freshwater. Each 
aquifer’s geology is unique in terms of its effect on stored brackish water. For example, the 
Carrizo-Wilcox Aquifer in Texas has hundreds of feet of siltstone and sand or a type of less 
permeable rock that can aid in the process of desalination (Wagner, 2015). Caution about the 
contamination of freshwater sources is advised.  

4.6 Tamaulipas ArcGIS Implementation 
As hydraulic fracturing activities develop in Tamaulipas, road damage will occur. This study 
focuses on oil and gas truck traffic patterns and provides an Early Warning System (EWS) tool 
to help officials better-forecast future damages and assures proper measures are in place. By 
creating a model of the road network with ArcGIS, the possible routes for travel between 
locations can be configured where traveled path lengths will be shortened by a significant 
degree. When describing an infrastructure system, it is useful to have gathered functional 
classification information about the roads in question.  

In studying of road network of Tamaulipas, several items were supplied for the analysis. 
The research team was able to obtain information about the roads and sourced water, which are 
only the two primary concerns. The analysis for Tamaulipas is not complete, since it is only 
factoring in the components that have been agreed on. The biggest missing piece of this puzzle is 
the water disposal site locations. As we learned in the study, the water routes that trucks take are 
the most damaging to the road network. Information about the water disposal sites would have 
addressed the impact this type of heavy pavement loading associated with hydraulically fractured 
sites. This additional piece of information would have provided a more complete analysis. 
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4.6.1 Acquiring Editable Data 
The objective of this study was to characterize the potential for accelerated pavement wear in 
Tamaulipas as a result of the unusual heavy truck traffic with the lessons learned from the Texas 
Study. The research team organized all of the information provided by Mexico and other reliable 
sources to model roads that would receive the highest impact from fracking. In the model, 
several datasets were layered considering Federal Roads of Mexico, Hydraulically Fractured 
sites, and wastewater treatment facilities as Water Sources. These components allow forecasting 
which pavement locations are most at risk. Determining the locations that require preemptive 
maintenance can result in proper allocation of funds and a reduction of future roadway costs. 
These datasets include source locations for the following: 
 

1. Federal roads of Mexico. The government of Tamaulipas was able to gather information 
about federal, state, municipal, and dirt roads. Given its size and connectivity to the road 
network, it was necessary to use an alternate source layer, especially when locating the 
wells outside of the state. For the purposes of analysis, the entire network of Mexico’s 
federal roads was utilized.  

2. Hydraulically fractured sites. Data for wells was obtained from the government of 
Tamaulipas to ensure that proper locations were being analyzed for the purpose of this 
assignment. Only exploratory wells for the region have been drilled. These hydraulically 
fractured sites are merely a sample of the area’s true potential. These points for well 
locations were obtained through Google Earth as coordinates that were imported to 
ArcMAP. 

3. Wastewater treatment plants as water sources. Locations for water sources were 
provided in an Excel format as x- and y- coordinates from the government of Tamaulipas. 
For now, the State Water Commission has determined the best water source to be used 
for fracking activities as the water treatment plants. The wastewater treatment plants at 
Nuevo Laredo and Reynosa have been identified as the top water source candidates 
because they can produce as least 1,000 lps, which is enough water for 30 perforations 
per week. Wastewater treatment plants are in general the most preferred source because 
using treated wastewater, rather than fresh water, does not compete with population and 
agricultural needs for fresh water. With this particular model, the shortest routes between 
hydraulically fractured sites and water sources will be generated, showing roads 
experiencing heavy pavement loading. The Network Analyst tool for a Closest Facility 
will allow these routes to be identified. 

4.7 Setting up the Model 
This model generates shortest routes between hydraulic fracturing sites and water sources to 
show roads experiencing heavy pavement loading. The Network Analyst tool for a Closest 
Facility will find the shortest paths. First, the data must be accessible to ArcMAP. Keep all 
necessary data in a folder named Model and have an additional folder set-aside as Trials. It is 
important to have all the critical information together in one folder and all of the experimental 
work in another. In creating a model, it will be easy to trace back the files added into ArcMAP 
and those files created while running tools. 

Altogether, seven files should be assigned to any given shapefile. Each file represents a 
different component for ArcMAP that allows for information to be displayed geographically on 
the page, given the attribute information (.dbf), coordinate system (.prj), spatial index features 
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(.sbn and .sbx), main geometry (.shp), and index of geometry (.shx). Be certain that the Federal 
Roads of Mexico have these seven existing files. These existing files will allow for the dataset to 
be easily added into ArcMAP. 

Since the hydraulically fractured wells were obtained via Google Earth as a KMZ file, 
open Google Earth and save the file as a KML in your designated folder. It is also possible to 
manually collect the x- and y- coordinates into an Excel sheet for comparison. This manual 
method of collecting points is done by hovering over each well location. (If manually collecting 
points, save the Excel file using the Microsoft 97 version.) 

Open the Excel file with the water sources. View the column titles and data type. Make 
sure everything is well organized and save as a Microsoft Excel 97 file type. ArcMAP recognizes 
only certain file types, so this step is critical to the process of adding data. Throughout this 
assignment, remember that the ArcMAP Catalog will help in connecting to folders, finding tools 
in ArcToolbox, and creating new layers in the form of points, lines, or polygons. It can be a 
useful window when needing the changeover coordinate systems. 

 In all models, it is required that the datasets be given proper coordinate systems based on 
their locations. Tamaulipas is located in zone 14 of the Universal Transverse Mercator (UTM) 
System. Start-up ArcMAP and connect to the Model folder to check each dataset and ensure the 
coordinate system is defined. Notice that the two sets of data must be converted into a shapefile 
for analysis in ArcMAP: Hydraulically Fractured wells and Water sources. 

 
1. Using the ArcToolbox within the ArcMAP Catalog, click on the KML to Layer under 

From KML within the Conversion Tools folder. This tool will allow for the KML file to 
be changed over to a layer in ArcMAP. Input the Hydraulically Fractured wells KML 
file. In output box, name layer for the file as Hydraulically_Fractured_Wells.shp and 
make sure it is designated to the Model folder. Notice that the coordinate system for this 
layer will already be defined since it was pulled from Google Earth. The dataset layer 
will have a WGS84 coordinate system.  

2. Change the coordinate system by clicking on Project under Projections and 
Transformations within the Data Management folder of ArcToolbox. Input the 
shapefile for Hydraulically Fractured wells. Output the file named Wells within the 
Model folder. Choose the appropriate coordinate system for the State of Tamaulipas as 
described (Projected Coordinate Systems>UTM>WGS 1984>Northern 
Hemisphere>WGS 1984 UTM Zone 14N). Click OK and a new layer will be created 
from the Project tool. When finished processing, the layer will be added in the Table of 
Contents of ArcMAP. The well sites will be given in Data view.  

3. Also within the ArcToolbox of the ArcMAP Catalog, click on Make XY Event Layer 
under Layers and Transformations in the Data Management folder. Excel tables with 
x- and y- coordinates can be turned into layers by using this particular tool. For the input, 
navigate to the Water sources excel table. The output should be named Water.shp within 
the Model folder. Define the coordinate system and click OK to create the new layer. 

In adding data into ArcMAP, there are two ways to perform layering—either by using the 
Catalog or clicking on Add data under File, add in each of the datasets including the 
federal roads of Mexico, hydraulically fractured sites, and water sources. Note: The 
hydraulically fractured sites and water sources were already added given the previous two 
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steps and their coordinate systems have been changed over. The only dataset that must be 
added is the Federal Roads of Mexico shapefile (Figure 4.9).  

4. Use the Catalog of ArcMAP to reach the ArcToolbox once again. In this step, the 
coordinate system of the Federal Roads shapefile will be projected over to a new 
coordinate system so that each of the layers has the same spatial arrangement in 
ArcMAP. Click on Project under Projections and Transformations within the Data 
Management folder of ArcToolbox. Input the shapefile for the Federal Roads of Mexico. 
Output the file named Roads within the Model folder. Choose the appropriate coordinate 
system for the State of Tamaulipas as described. Click OK and a new layer will be 
created from the Project tool. 

Each of the layers should now be viewable in ArcMAP. Check to see if the files were stored in 
the folder labeled Model by using the ArcMAP Catalog and connecting to the folder. Three 
additional shapefile type files should be listed: Wells, Water, and Roads. Use symbols to 
customize each dataset as needed. The symbology tab can be found by double clicking on one of 
the layers to be customized.  

    

Figure 4.9 Road Network of Mexico 
(Source: Hijmans, 2011; Tamaulipas, 2015) 
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ArcGIS is software used to layer information geographically. It allows the user to 
display maps of needed area. This model will identify the best routes to and from a given 
location. 

4.7.2 Closest Facility, Shortest Paths  
The next step is to design a road network in ArcMAP with the Network Analyst tool. This tool 
involves the Closest Facility concept of locating the shortest paths between known points. 

1. Activate the Network Analyst Extension using the main panel within ArcMAP. Click on 
Customize and click Extensions. Check the box next to Network Analyst to activate. 
Add in the Network Analyst Toolbar by clicking on Toolbars within Customize and 
click Network Analyst.  

2. On the right side of the ArcMAP main bar, click on the Window tab and select Catalog 
from the dropdown menu. Locate the folder containing the roads that will be used in the 
model. Right click on the road file: 

> Select “New Network Dataset…” This will open a window to help build a network 
dataset.  
 Window will read: Enter a name for your network dataset. Type in the name of the file 
containing the roads, i.e. “Roads” 
Window will read: Do you want to model turns in this network? Select YES. 
> Select Connectivity policy is end points 
Window will read: How would you like to model the elevation of your network features? 
> Select NONE.  
> Select proper units, i.e. “Miles”. 
> Click Next. 
Window will read: Do you want to establish driving direction settings for this network 
dataset? This depends on the user output needs, however, for this model we chose NO.  
> Select Finish. 

 
Three layers will be made in the Network Analyst: edges to the network, street lines, and 

junctions. For the purpose of this assignment, only street lines are necessary for analysis. To find 
the shortest paths, street lines are used to connect the origins and destinations. Incidents are 
serviced by the closest Facilities. In this case, hydraulically fractured wells are the “incidents” 
getting served by the closest “facility” or water. (When determining the paths from incidents to 
facilities, always assume that the incidents will be locations where wells are being drilled. The 
facilities should change depending on the resources being transported, whether it is sourced 
water, disposed water, sand, or gravel.) With the Closest Facility Network Analyst Tool, route 
assignments will be generated, after which ESAL values will be added to identify the locations 
of heavy loadings.  

 

1. On the Network Analyst Toolbar,   (See 
section 3.2.7 where the toolbar was activated.) click on the black arrow near Network 
Analyst and choose New Closest Facility. In the Network Analyst Window,  
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2. Right click on Facilities > Load locations… > Load from: Select the file containing 
facilities of interest, i.e., Water Sources).  

3. Make sure Location Position is set to “Use Geometry”. Define the radius tolerance for 
the facility search. In this case, the radius was set to 10 miles, to connect the facility to 
the nearest network lines within a 10 mile radius.  

4. Click OK to load facilities.  
The same method can be followed to load the other information as incidents. Now the 
facilities and incidents locations are loaded.  

5. Click on the Solve button  in the Network Analyst Toolbar to find the shortest 
paths. Figure 4.10 displays the output of the Network Analyst Tool with the shortest 
routes between quarries and oil wells. 

 

 

Figure 4.10 Closest Facility, Shortest Paths 
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The ESAL values are a critical measure to associate with each route. A field will be added in the 
attribute table explaining how the ESAL values determine whether a route is experiencing 
pavement damage.  
 

1. Export the routes out of the Closest Facility output by right clicking on the Routes tab. 
Click on Data and then click Export Data. Connect to the Model folder and name the 
shapefile Routes. The data will be added to the map in the form of a layer. 

2. On the new Routes layer, Open Attribute Table and navigate to Table Options to 
Add Field. Name the field ESAL. (The type will be Double which refers to numerical 
values needing a fifteen decimal precision.) Click OK. 

3. Right click on the ESAL field in the Attribute Table and click Field Calculator. When 
the Field Calculator dialog box opens showing “ESAL=”, type 8824 to show the ESAL 
value being applied by the average number of 100 Kip trucks carrying water to one 
hydraulically fractured well. This calculation will help in determining the critical areas of 
impact along the routes.  

4.7.3 Critical Areas of Impact 
In ArcMAP, symbols can be changed to help represent the impact taking place on a given route. 
With the use of various tools, the routes can be classified based on their importance. Here, only 
water sources are represented. Routes produced from hydraulically fractured wells to water 
sources reflect consistency, but noting the direction of the most traffic can reflect pavements 
being damaged. In other words, the multiple trips occurring on a path from a facility indicates 
that the roads closer to the water sources are experiencing a higher amount of truck traffic 
compared to roads closer to the well locations themselves.  
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Figure 4.11 ESAL Critical Segments 
 

Figure 4.11 points out the critical segments showing the impacts of trucks traveling from 
the water sources. Specifically, critical segment 1 notes that there are exactly 6 hydraulically 
fractured wells being supplied water. The impact on the pavement from traveling on this 
particular segment, Mexican Federal Highway 40, is greater than the impact in other areas. 
About 52944 ESALs are being loaded to this surface (6 wells x 8824 ESALs for water = 52944 
ESALs). There are a large number of trucks coming to this particular source for water. In fact, 
the rural roadways in the proximity of residual wastewater treatment plant for Reynosa No.2 will 
experience high volumes of traffic given that 6 wells will need to retrieve water from this 
location. Further South, Critical segment 2 explains that there are 4 hydraulically fractured wells 
receiving water by use of the Interstate Highway El Becerro, and the pavement surface is loaded 
with 23296 ESALs (4 wells x 8824 ESALs for water = 23296 ESALs). On the same roadway 
Interstate Highway El Becerro, critical segment 3 services three different hydraulically fractured 
wells. The loading applied to the surface on Interstate Highway El Becerro equals approximately 
26472 ESALs total with 8824 ESALs per round trip for the transporting of water per well. 
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4.7.4 ESAL Loading on Routes 
Using the Spatial Analyst is another way in classifying areas of importance. Activate the 
Extension under the Customize tab on the toolbar. The Line Density tool must be used to 
calculate polyline feature density. ArcGIS Resource Center defines the line density tool as a 
calculation involving the length of the line, population field, and the area of the grid cells.  
Default lines generated through the output of the network analyst set the grid cells. Only the 
length of the line and population field will be required for analysis. 

 
1. From the ArcToolbox under the Spatial Analyst Tools within the Density folder, choose 

Line Density (This tool can also be found by using the Search window). For the Input 
Polyline features, connect to the Model folder and input the Routes shapefile. In the 
Population field, select ESAL. Output the file ESAL_Density.shp. Run the tool. A Line 
Density layer will be created in ArcMAP.  

2. Change the symbology of the layer to resemble high to low ESAL values. The Color 
Ramp can be adjusted to show the density of ESAL values for hydraulically fractured 
sites to water sources. These changes will allow for a better explanation of which roads 
are experiencing the most pavement impact. 

 
With the line density tool, routes were identified by finding their magnitude per unit area. 

The polyline features (routes) would fall within a 10 mile radius around each cell. In Figure 4.12, 
the ESAL Density Routes are geographically displayed showing high values in black and low 
values in white. This tool helps in seeing which segments experience heavy truck traffic due to 
water being transported in the area. 
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Figure 4.12 ESAL Density of Routes 

4.7.5 Pavement Impact in Tamaulipas 
One final application to apply in ArcMAP will allow for the assessment of damage on each 
route. This analysis will provide a hierarchy of importance for segments based solely on the 
ESAL values. Notice that in this model that water sources are the main concern. Routes have 
been drawn to and from hydraulically fractured wells knowing only these locations.  

1. Use the Search window to find the Merge tool (Otherwise, the tool can be found under 
the Geoprocessing tab of the main panel). This tool will combine all the routes within one 
shapefile. When the Merge dialog box opens, input the layer Routes for Input Datasets 
(Only water sources are being routed). For the Output Dataset, save as All_Routes.shp. 
A new layer will be created and added to the Table of Contents. Check the Attribute 
Table to see that the fields were carried over after merging the routes. (Using this tool, 
basically lead to the re-naming of the shapefile.) 

2. Search for the Dissolve tool (Check in ArcToolbox under Data Management within the 
Generalization folder). Input the file All_Routes. Output the file name 
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All_Routes_Diss.shp. All routes will be dissolved into one, and there will be no breaks in 
the segments. 

3. In ArcToolbox of Data Management under the Features folder, click on Feature 
Vertices to Points. Input Features would be All_Routes. Output Feature Class is 
All_Routes_Endpoints.shp. Point type resembles ALL (Point type is an important 
distinctive measure used in this analysis. The types vary among ALL, MID, START, 
END, BOTH_ENDS, or DANGLE. Deciding on the point type is the user’s call.). The 
endpoints represent in the model where the routes start and end when looking at the 
merged routes. 

4. In the same Features folder, choose Split Line at Point. Input Features will include 
All_Routes_Diss. Point Features are to represent All_Routes_Endpoints. Output 
Feature Class will be called All_Routes_Split. Click Ok. A new layer and shapefile will 
be added. Each time a given route experiences a different ESAL loading, a change in 
total ESAL should be seen.  

5. Open the Attribute Table for All_Routes_Split. Check to see that the calculations for 
ESAL values were made.  

6. Right-click on the layer in the Table of Contents. Navigate to Join and Relates and 
click Join. The Join Data Dialog box is opened. For the dropdown menu of What do you 
want to join to this layer, choose Join data from another layer based on spatial location. 
On the first prompt, input All_Routes. The second prompt checked should read  
‘Each line will be given a summary of the numeric attributes of the lines in the layer 
being joined that intersect it, and a count field showing how many lines intersect it.’ 

7. How do you want the attributes to be summarized? Check SUM. Output shapefile named 
Total_ESAL.shp and click OK. Check the Attribute Table and the ESAL calculation 
under the field SUM_ESAL.  

8. For this particular model, the SUM_ESAL values had to be adjusted while in Edit. Under 
Customize, click Toolbars and add-in the Edit toolbar to Start Editing. Manually 
calculate each value and add them in accordingly. There is a flaw in the system from 
having only one dataset to represent facilities. When analyzing various routes for 
different resources being carried, the model will adjust itself having more variables to 
apply. Remember: When working with ArcMAP, it is crucial to run through each model 
and understand the outputs from the tools being used. Miscalculated fields can be re-
calculated and justified by the user. 
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Figure 4.13 Total ESAL, Pavement Impact 
 

This model visually explains the effects from increased truck traffic due to hydraulic 
fracturing in Tamaulipas, Mexico (Figure 4.13). It reflects on the damage done to pavement 
when carrying water to and from hydraulically fractured wells. The main routes of concern are 
closer to the water sources. Major effects on pavement will be seen on routes experiencing large 
amounts of truck traffic. To ensure that the state reaches its true potential in infrastructure, these 
analyses were created to improve highways and roads. Whether thick overlays or surface 
treatments are applied to strengthen a roadway, these models help make traveling easier during 
petroleum prospecting activities.  

4.8 Automated Approach 
An alternative method is to use ModelBuilder within ArcMAP when processing the data. In 
ModelBuilder, the user can input a dataset for editing purposes and apply tools to receive a 
desired output when solving. This alternative method means quicker processing of results for 
analysis. The ModelBuilder can be used multiple times to output routes experiencing loading. To 
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build a workflow diagram in ArcMAP, processing can be delivered in a flash by using a visual 
programming language. With ease, the model can be created and modified to represent chains of 
information. Subsequently, the tools within ArcMAP are used to set-up the functionality of 
ModelBuilder.  

 

4.9 Conclusion 
Using GIS based approaches for predicting potential truck traffic will enable identification of 
road segments likely to experience accelerated deterioration. Each model predicts truck trips and 
related ESAL loading for specific areas adjacent to hydraulically fractured well sites. The routes 
are crucial in visualizing how truck traffic will behave during construction. This modeled 
network created for Tamaulipas identifies road segments that need to be improved with regard to 
the amount of loading each segment is experiencing.  
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Chapter 5.  Moving Forward on Fracking Initiatives in Mexico:  
Summary and Recommendations 

5.1 Texas Study and Experience 
Information has been provided about the Texas experience and how to predict or prevent serious 
damage to road pavements. Transportation of equipment, water, and other resources is required 
when constructing and operating wells drilled using hydraulic fracturing techniques. Activity in 
oil and gas unconventional shale plays suggests that these resources will be transported through 
the use of a large number of heavy trucks. Unforeseen truck travel in large amounts can affect 
pavement that has not been designed to withstand significant truck loading.  

In Texas, large numbers of hydraulically fractured wells were identified along with water 
sources, water disposal sites, aggregate sources, and equipment concentration sites. 
Construction-related truck traffic on highway paths were mapped based upon truck sizes and 
weights. With calculated AASHTO equivalent axels (ESALs), predictions can be made about the 
amount of damage to a surface or pavement life consumed by heavy truck traffic. Commonly 
used for design and maintenance of Texas highway pavements, the equivalent axle concept was 
developed from the AASHO Road Test. Calculations for equivalent axle loading depend on 
vehicle and axle weights and their frequency of occurrence.   

5.2 GIS Implementation for Tamaulipas 
Thus far, in Mexico only a few hydraulically fractured wells have been drilled. Within the state, 
there are expectations for significant drilling activity as lease blocks get awarded at the end of 
each tender round. These GIS applications introduced can be used to geographically pinpoint 
routes where future pavement damage will occur. The extensive instructions within this report 
give a complete description of the utility of the GIS system. The system output capabilities are 
noted for Texas, where more information is readily available. It shows the segments undergoing 
frequent truck travel and how the pavements have been loaded, given the ESAL values. 
Equivalent axle loading varies slightly from the Texas example. The maximum allowable vehicle 
weight in Texas is 80,000 pounds. A tank truck used to transport fresh and waste water might 
exceed the maximum 80,000 pounds if filled to capacity. As a worst-case scenario, a maximum 
vehicle weight of 100,000 pounds was used for calculations in Tamaulipas.  

5.2.1 Analysis in ArcMAP 
The GIS framework is based on geographically representing paths and total equivalent axle 
pavement loadings to identify road segments that need strengthening. In withstanding heavy 
truck traffic associated with hydraulic fracturing, segments of roadways should be located and 
recognized in order to prevent damage. The analysis uses routing by closest facility paths or 
shortest paths to and from the hydraulically fractured wells. This modeling helps explain how 
truck travel will take place during the construction and production phases as resources are 
transported to and from the well sites.  

5.2.2 Existing Road Network 
For purposes of the GIS system, the roads in Tamaulipas are classified into four distinguishable 
parts: the federal network, state highways, rural roads, and improved connectors. Particular paths 
are identified including the four road types. The model will signify changes in truck traffic due to 
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hydraulic fracturing providing a better view of pavements experiencing heavy truck traffic and 
therein unusual significant wear.  

Implementing appropriate measures for the existing road network is managed by the 
Secretaria de Comunicaciones y Transportes (SCT), which seeks to sustain the economic growth 
in Tamaulipas. They have the responsibility to regulate the country’s transportation (SENECA 
2014).! ! Investments in transportation can represent a shift in planning and spending in areas 
where it is most needed. 

5.3 Ensuring Pavement Life, Quick Fixes 
The road network in Tamaulipas is critical to the expected truck traffic for the area. Hydraulic 
fracturing taking place has prompted preemptive measures be put in place so that increases in 
truck travel can be located before damage of a roadway causes it to fail. Depending on the traffic 
volume, different methods can be utilized to prepare roads for increased traffic. Quick fixes may 
be possible in some instances, whereas other roads experiencing a high volume of traffic may 
have much more accelerated pavement damage. 

In Michigan, studies have been performed on flexible pavement to determine the best 
mixes to repair damaged roadways. Depending on the impact the pavement is experiencing, 
materials may be altered to minimize the effects of heavy truck traffic. Adverse weather or high 
temperature conditions can cause cracks in pavement initiating accelerated damage to road 
quality. These transverse cracks can be treated by sealing or by use of a thin overlay if traffic 
loading is minimal, however, such repairs are insufficient to repair the damage that would occur 
with heavy truck traffic associated with hydraulic fracturing. Roads can be quickly damaged 
beyond repair by thousands of passes of heavily loaded trucks traveling to and from the wells.  

This GIS system has been created to enable users to add location data for future water 
sources, future water disposal sites, future aggregate sources, and equipment concentration sites. 
The system uses ESRI’s software system ArcGIS. It is one of the most widely and readily 
available GIS software applications in the world.  

The report provides instructions for updating the GIS system as more well locations are 
identified, as more water sources are identified, and as water disposal sites are identified over 
time.        
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APPENDIX A  

AASHTO Pavement Design Factors for Single Axle Loading 
 

Table!D.4.! Axle!load!equivalency!factors!for!flexible!pavements,!single!
axles!and!Pt2.5!

Axle!Load!
(kips)!

Pavement!Structural!Number!(SN)!
1! 2! 3! 4! 5! 6!

2! 0.0004! 0.0004! 0.0003! 0.0002! 0.0002! 0.0002!
4! 0.003! 0.004! 0.004! 0.003! 0.002! 0.002!
6! 0.011! 0.017! 0.17! 0.013! 0.01! 0.009!
8! 0.032! 0.047! 0.51! 0.041! 0.034! 0.031!

10! 0.078! 0.102! 0.118! 0.102! 0.88! 0.08!
12! 0.168! 0.198! 0.229! 0.213! 0.189! 0.176!
14! 0.328! 0.358! 0.399! 0.388! 0.36! 0.342!
16! 0.591! 0.613! 0.646! 0.645! 0.623! 0.606!
18! 1! 1! 1! 1! 1! 1!
20! 1.61! 1.57! 1.49! 1.47! 1.51! 1.56!
22! 2.48! 2.38! 2.17! 2.09! 2.18! 2.3!
24! 3.69! 3.49! 3.09! 2.89! 3.03! 3.27!
26! 5.33! 4.99! 4.31! 3.91! 4.09! 4.48!
28! 7.49! 5.98! 5.9! 6.21! 5.39! 5.98!
30! 10.3! 9.5! 7.9! 6.8! 7! 7.8!
32! 13.9! 12.8! 10.5! 8.8! 8.9! 10!
34! 18.4! 16.9! 13.7! 11.3! 11.2! 12.5!
36! 24! 22! 17.7! 14.4! 13.9! 15.5!
38! 30.9! 28.3! 22.6! 18.1! 17.2! 19!
40! 39.3! 35.9! 28.5! 22.6! 21.1! 23!
42! 49.3! 45! 25.6! 27.8! 25.6! 27.7!
44! 61.3! 55.9! 44! 34! 31! 33.1!
46! 75.5! 68.8! 54! 41.4! 37.2! 39.3!
48! 92.2! 83.9! 65.7! 50.1! 44.5! 46.6!
50! 112! 102! 79! 60! 53! 55!
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AASHTO Pavement Design Factors for Tandem Axle Loading 
 

Table!D.5.! Axle!load!equivalency!factors!for!flexible!pavements,!tandem!
axles!and!Pt2.5!

Axle!Load!
(kips)!

Pavement!Structural!Number!(SN)!
1! 2! 3! 4! 5! 6!

2! 0.0001! 0.0001! 0.0001! 0! 0! 0!
4! 0.0005! 0.0005! 0.0004! 0.0003! 0.0003! 0.0002!
6! 0.002! 0.002! 0.002! 0.001! 0.001! 0.001!
8! 0.004! 0.006! 0.005! 0.004! 0.003! 0.003!

10! 0.008! 0.013! 0.011! 0.009! 0.007! 0.006!
12! 0.015! 0.024! 0.023! 0.018! 0.014! 0.013!
14! 0.026! 0.041! 0.042! 0.033! 0.027! 0.024!
16! 0.044! 0.065! 0.07! 0.057! 0.047! 0.043!
18! 0.07! 0.097! 0.109! 0.092! 0.077! 0.07!
20! 0.107! 0.141! 0.162! 0.141! 0.121! 0.11!
22! 0.16! 0.198! 0.229! 0.207! 0.18! 0.166!
24! 0.231! 0.273! 0.315! 0.292! 0.26! 0.242!
26! 0.327! 0.37! 0.42! 0.401! 0.364! 0.342!
28! 0.451! 0.493! 0.548! 0.534! 0.495! 0.47!
30! 0.611! 0.648! 0.703! 0.695! 0.658! 0.633!
32! 0.813! 0.843! 0.889! 0.887! 0.857! 0.834!
34! 1.06! 1.08! 1.11! 1.11! 1.09! 1.08!
36! 1.38! 1.38! 1.38! 1.38! 1.38! 1.38!
38! 1.75! 1.73! 1.69! 1.68! 1.7! 1.73!
40! 2.21! 2.16! 2.06! 2.03! 2.08! 2.14!
42! 2.76! 2.67! 2.49! 2.43! 2.51! 2.61!
44! 3.41! 3.27! 2.99! 2.88! 3! 3.16!
46! 4.18! 3.98! 3.58! 3.4! 3.65! 3.79!
48! 5.08! 4.8! 4.25! 3.98! 4.17! 4.49!
50! 6.12! 5.76! 5.03! 4.64! 4.86! 5.28!
52! 7.33! 6.87! 5.93! 5.38! 5.63! 6.17!
54! 8.72! 8.14! 6.95! 6.22! 6.47! 7.15!
56! 10.3! 9.6! 8.1! 7.2! 7.4! 8.2!
58! 12.1! 11.3! 9.4! 8.2! 8.4! 9.4!
60! 14.2! 13.1! 10.9! 9.4! 9.6! 10.7!
62! 16.5! 15.3! 12.6! 10.7! 10.8! 12.1!
64! 19.1! 17.6! 14.5! 12.2! 12.2! 13.7!
66! 22.1! 20.3! 16.6! 13.8! 13.7! 16.4!
68! 25.3! 23.3! 18.9! 15.6! 15.4! 17.2!
70! 29! 26.6! 21.5! 17.6! 17.2! 19.2!
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Table!D.5.! Axle!load!equivalency!factors!for!flexible!pavements,!tandem!
axles!and!Pt2.5!72! 33! 30.3! 24.4! 19.8! 19.2! 21.3!

74! 37.5! 34.4! 27.6! 22.2! 21.3! 23.6!
76! 42.5! 38.9! 31.1! 24.8! 23.7! 26.1!
78! 48! 43.9! 35! 27.8! 26.2! 28.8!
80! 54! 49.4! 39.2! 30.9! 29! 31.7!
82! 60.6! 55.4! 43.9! 34.4! 32! 34.8!
84! 67.8! 61.9! 49! 38.2! 35.3! 38.1!
86! 75.7! 69.1! 54.5! 42.3! 38.8! 41.7!
88! 84.3! 76.9! 60.6! 46.8! 42.6! 45.6!
90! 93.7! 85.4! 67.1! 51.7! 46.8! 49.7!

 

ESAL Values 
To quantify current pavement condition, the AASHTO serviceability concept was developed. 
The indices for serviceability used in design procedures include: initial serviceability (pi) and the 
terminal serviceability (pt). Major highways may have a terminal serviceability index of 2.5 or 
3.0; whereas roads with a lower highway classification may allow lower terminal serviceability 
values such as 2.0. The AASHTO pavement design method provides equivalent single axle load 
values that indicate the number of passes of an 18,000 pound single axle that would cause the 
same damage to the pavement as one pass of any given axle weight. The numbers for 
equivalence values are reliant on two items: the terminal serviceability used in design and the 
structural number (SN) which describes the strength of the pavement (AASHTO, 1993). 



 76 

 

  



 77 

APPENDIX B  

ArcGIS Tools for Processing  
 

Tool  Toolbox Tool Reference Function 
Define Projection Data Management Projections and 

Transformations 
Overwrites the 
coordinate system of the 
dataset  

Project Data Management Projections and 
Transformations 

Projects spatial data 
from one coordinate 
system to another 

Make XY Event Data Management Layers and Table Views Creates new point 
feature based on x- and 
y- coordinates in source 
table 

KML to Layer Conversion To KML toolset Converts KML or KMZ 
into feature class 

ArcGIS Tools for Selecting Features 
 

Tool Toolbox Tool Reference Function 
Select Feature Analysis Tools Extract Allows for identifying 

features within the map 
using Structures Query 
Language (SQL) 

Select Layer by 
Attribute 

Data Management Layers and Table Views Adds, updates, removes, 
a selection in attribute 
table 

Select Layer by 
Location 

Data Management Layers and Table Views Selects features in layer 
based on spatial 
relationships 

ArcGIS Toolbars for Analysis 
 

Toolbar 1st Window 2nd Window Function 
Standard Customize Toolbars Acts as the main 

functions within 
ArcMap 

Network Analyst Customize Toolbars Allows for a system to 
be built interconnecting 
elements that represent 
possible routes 

Spatial Analyst Customize Toolbars Breaks down categories 
of related functionality 

Edit  Customize Toolbars Compiles and updates 
geographic data 

Draw Customize Toolbars Optimizes performance 
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in design  
Snapping Customize Toolbars Establishes accuracy 

when drawing segments 
between features 

 

ArcGIS Tools for Creating the Model 
 
Tool Toolbox Tool Reference Function 
Create Feature Class Data Management Tools Feature Class Creates an empty, 

editable feature class 
Create Fishnet Data Management Tools Feature Class Builds a rectangular 

fishnet from polygon 
features 

Integrate Data Management Tools Feature Class Processes feature 
boundaries that are 
within a given tolerance 

Clip Analysis Tools Extract Removes input features 
from clip features 
creating a new study 
area 

Make Closest Facility 
Layer 

Network Analyst Tools Analysis Determines the closest 
facility or facilities to an 
incident based on travel 
time, distance, etc. 

Add Field Data Management Tools Fields Adds a new field to a 
table for the purposes of 
labeling and identifying 
a feature class 

Intersect Analysis Tools Overlay Geometrically 
calculates an 
intersection between 
input features 

Line Density Spatial Analyst Tools Density Computes the 
magnitude per unit area 
defined around the 
radius of each cell’s 
features  

Weighted Sum Spatial Analyst Tools Overlay Multiplies and sums the 
weight of several 
overlaying rasters 

 

ArcGIS Interpreting Total Loading Ranges on Segments Step-by-step Tool Guide 
Step Tool Toolbox Tool 

Reference 
Input Output Function 

1 Merge Data 
Management 

General water sources, water 
disposal sites, 

All_Routes Combines 
input 
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Tools aggregate sources, etc.  datasets of 
the same 
type into a 
new dataset 

2 Feature 
Vertices 
to Points 

Data 
Management 
Tools 

Features All_Routes All_Route 
EndPoints 

Generates 
points from 
vertices or 
locations on 
features 

3 Dissolve Data 
Management 
Tools 

Generalization All_Routes All_Routes_Diss Features are 
summarized 
and scaled 
based on 
their 
attributes 

4 Split 
Line at 
Point 

Data 
Management 
Tools 

Features Input Features: 
All_Routes_Diss 
Point Features: 
All_Routes_Endpoints 

All_Routes_Split Creates 
splits at 
intersections 
on point 
features 

5 Spatially 
Join  

Join and 
Relates 

Join… (check 
SUM) 

Water sources + water 
disposal sites + 
aggregate sources + 
etc. 

Join_Output, … 
Total_ESAL 

Establishes 
a spatial 
relationship 
between 
features 

 

Measurement Scales for Types of Data 
Attribute Type Data Type / Numeric 

Storage 
ArcGIS Operations 

Nominal  String, Byte, Integer Text, Short or Long 
Integer 

Query, Sort, No 
Math 

Ordinal  Byte, Integer Short or Long 
Integer 

Quartile Analysis 

Cardinal / Interval Integer, Float, 
Double 

Short or Long 
Integer, Float, 
Double 

Subtraction, 
Addition 

Date Date Date Subtraction, 
Addition 

Ratio Float, Double Float, Double All math operations, 
except complex 

*Byte: signed or unsigned 
 Short Integer: Roughly +/- 32 thousand 
 Long Integer: +/- 2 billion (32-bit machine) 
 Float: 7 decimal precision 
 Double: 15 decimal precision 
 Note: as you descend the scale, operations are cumulative 
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